| KU580 User Guide |
- English

This document is the user guide for the

LG KU580 3G Video Mobile Phone.

All rights for this document are reserved by
LG Electronics. Copying, modifying and
distributing this document without the
consent of LG Electronics are prohibited.

Disposal of your old appliance
ﬁ 1. When this crossed-out wheeled bin symbol is attached to a product it means
mmmm the product is covered by the European Directive 2002/96/CE.
2. All electrical and electronic products should be disposed of separately from the
municipal waste stream via designated collection facilities appointed by the
government or the local authorities.

W

. The correct disposal of your old appliance will help prevent potential negative
consequences for the environment and human health.

4. For more detailed information about disposal of your old appliance, please

contact your city office, waste disposal service or the shop where you purchased

the product.
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Introduction

Congratulations on your purchase of the
advanced and compact KU580 3G video
mobile phone, designed to operate with the
latest digital mobile communication
technology.

This user’s guide contains important
information on the use and operation of
this phone. Please read all the
information carefully for optimal
performance and to prevent any damage
to or misuse of the phone. Any changes
or modifications not expressly approved
in this user’s guide could void your
warranty for this equipment.

Use of phone cases with magnetic locks
with slide type phones has caused
problems such as loss of network signal
and phones powering off.



Part 15.21 statement

" Change or Modifications that are not expressly approved by the manufacturer could void

the user's authority to operate the equipment. "

Part 15.105 statement

This equipment has been tested and found to comply with the limits for a class B digital device,
pursuant to Part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference in a
residential installation.

This equipment generates uses and can radiate radio frequency energy and, if not installed and used

in accordance with the instructions, may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. if this

equipment does cause harmful interference or television reception, which can be determined by

turning the equipment off and on, the user is encouraged to try to correct the interference by one or

more of the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to

which the receiver is connected

- Consult the dealer or an experienced radio/TV technician for help.



LIMITED WARRANTY STATEMENT

1. WHAT THIS WARRANTY COVERS:

LG offers you a limited warranty that the enclosed subscriber unit and its enclosed accessories will be
free from defects in material and workmanship, according to the following terms and conditions:

(1) The limited warranty for the product extends for ONE (1) year beginning on the data of purchase
of the product.

(2) The limited warranty extends on to the original purchaser of the product and is not assignable or
transferable to any subsequent purchaser/end user.

(3) This warranty is good only to the original purchaser of the product during the warranty period as
long as itis in the U.S., including Alaska, Hawaii, U.S. Territories and Canada.

(4) The external housing and cosmetic parts shall not be covered under these limited warranty terms.
(5) Upon request from LG, the consumer must provide information to reasonably prove the date of
purchase.

(6) The customer shall bear the cost of shipping the product to the Customer Service Department of
LG. LG shall bear the cost of shipping the product back to the consumer after the completion of
service under this limited warranty.

2. WHAT THIS WARRANTY DOES NOT COVER:

(1) Defects or damages resulting from use of the product in other than its normal and customary
manner.

(2) Defects or damages from abnormal use, abnormal conditions, improper storage, exposure to
moisture or dampness, unauthorized modifications, unauthorized connections, unauthorized repair,
misuse, neglect, abuse, accident, alteration, improper installation, or other acts which are not the
fault of LG, including damage caused by shipping blown fuses spills of food or liquid.

(3) Breakage or damage to antennas unless caused directly by defects in material or workmanship.
(4) That the Customer Service Department at LG was net notified by consumer of the alleged defect
or malfunction of the product during the applicable limited warranty period.

(5) Products which have had the serial number removed or made illegible.

(6) The limited warranty is in lieu of all other warranties, express or implied either in fact or by
operations law, statutory or otherwise, including, but limited to any implied warranty of
marketability or fitness for a particular use.

(7) Damage resulting from use of non-LG approved accessories.

(8) All plastic surfaces and all other externally exposed parts that are scratched or damaged due to
normal customer use.

(9) Products operated outside published maximum ratings.
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(10) Products used or obtained in a rental program.

(11) Consumables (such as fuses).

3. STATE LAW RIGHTS:

No other express warranty is applicable to this product. THE DURATION OF ANY IMPLIED
WARRANTIES, INCLUDING THE IMPLIED WARRANTY OF MARKETABILITY, IS LIMITED
TO THE DURATION OF THE EXPRESS WARRANTY HEREIN. LG INFOCOMM INC. SHALL
NOT BE LIABLE FOR THE LOSS OF THE USE OF THE PRODUCT, INCONVENIENCE, LOSS
OR ANY OTHER DAMAGES, DIRECT OR CONSEQUENTIAL, RISING OUT OF THE USE OF,
OR INABILITY TO USE, THIS PRODUCT OR FOR ANY BREACH OF ANY EXPRESS OR
IMPLIED WARRANTY, INCLUDING THE IMPLIED WARRANTY OF MARKETABILITY
APPLICABLE TO THIS PRODUCT. Some states do not allow the exclusive of imitation of incidental
or consequential damages or limitations on how long an implied warranty lasts; so these limitations or
exclusions may not apply to you. This warranty gives you specific legal rights and you may also have
other rights which vary from state to state.

4. HOW TO GET WARRANTY SERVICE:

To obtain warranty service, please call the following web address:

www.lgeservice.com



For Your Safety

This user guide contains important information on the use and
operation of this phone. Please read all the information
carefully for optimal performance and to prevent any damage
to or misuse of the phone. Any changes or modifications not
expressly approved in this user guide could void your warranty
for this equipment.

Safety Instructions

WARNING! To reduce the possibility of electric shock, do not
expose your phone to high humidity areas, such as the
bathroom, swimming pool, etc.

Always store your phone away from heat. Never store your
phone in settings that may expose it to temperatures less than
32°F or greater than 104°F, such as outside during extreme
weather conditions or in your car on a hot day. Exposure to
excessive cold or heat will result in malfunction, damage
and/or catastrophic failure.

Be careful when using your phone near other electronic
devices. RF emissions from your mobile phone may affect
nearby in adequately shielded electronic equipment. You
should consult with manufacturers of any personal medical
devices such as pacemakers and hearing aides to determine if
they are susceptible to interference from your mobile phone.

Turn off your phone in a medical facility or at a gas station.
Never place your phone in a microwave oven as this will
cause the battery to explode.

IMPORTANT! Please read the TIA SAFETY INFORMATION on
page 78 before using your phone.

Safety Information

Read these simple guidelines. Breaking the rules may be
dangerous or illegal. Further detailed information is given in this
user guide.

Never use an unapproved battery since this could damage
the phone and/or battery and could cause the battery to
explode.

Never place your phone in a microwave oven as it will
cause the battery to explode.

Do not dispose of your battery by fire or with hazardous or
flammable materials.

Make sure that no sharp-edged items come into contact
with the battery. There is a risk of this causing a fire.
Store the battery in a place out of reach of children.

Be careful that children do not swallow any parts such as
rubber plugs (earphone, connection parts of the phone,
etc.). This could cause asphyxiation or suffocation.
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Unplug the power cord and charger during lightning storms
to avoid electric shock or fire.

When riding in a car, do not leave your phone or set up the
hands-free kit near to the air bag. If wireless equipment is
improperly installed and the air bag is activated, you may be
seriously injured.

Do not use a hand-held phone while driving.

Do not use the phone in areas where its use is prohibited.
(For example: aircraft).

Do not expose the battery charger or adapter to direct
sunlight or use it in places with high humidity, such as a
bathroom.

Never store your phone in temperatures less than- 4°F or
greater than 122°F.

Do not use harsh chemicals (such as alcohol, benzene,
thinners, etc.) or detergents to clean your phone. There is a
risk of this causing a fire.

Do not drop, strike, or shake your phone severely. Such
actions may harm the internal circuit boards of the phone.
Do not use your phone in high explosive areas as the phone
may generate sparks.

Do not damage the power cord by bending, twisting, pulling,
or heating. Do not use the plug if it is loose as it may cause
a fire or electric shock.

For Your Safety

Do not place any heavy items on the power cord. Do not
allow the power cord to be crimped as it may cause fire or
electric shock.

Do not handle the phone with wet hands while it is being
charged. It may cause an electric shock or seriously
damage your phone.

Do not disassemble the phone.

Do not place or answer calls while charging the phone as it
may short-circuit the phone and/or cause electric shock or
fire.

Only use the batteries, antennas, and chargers provided by
LG. The warranty will not be applied to products provided by
other suppliers.

Only authorized personnel should service the phone and its
accessories. Faulty installation or service may result in
accidents and consequently invalidate the warranty.

Do not hold or let the antenna come in contact with your
body during a call.

An emergency call can be made only within a service area.
For an emergency call, make sure that you are within a
service area and that the phone is turned on.
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For Your Safety

FCC RF Exposure Information
WARNING! Read this information before operating the phone.

In August 1996, the Federal Communications (FCC) of he United
States, with its action in Report and Order FCC 96-326, adopted
an updated safety standard for human exposure to radio
frequency (RF) electromagnetic energy emitted by FCC
regulated transmitters. Those guidelines are consistent with
the safety standard previously set by both U.S. and
international standards bodies.

The design of this phone complies with the FCC guidelines and
these international standards.

CAUTION

Use only the supplied and approved antenna. Use of
unauthorized antennas or modifications could impair call
quality, damage the phone, void your warranty and/or result in
violation of FCC regulations. Do not use the phone with a
damaged antenna. If a damaged antenna comes into contact
with skin, a minor burn may result. Contact your local dealer
for a replacement antenna.

Body-worn Operation

This device was tested for typical body-worn operations with
the back of the phone kept 0.79 inches (2cm) between the
user's body and the back of the phone. To comply with FCC RF
exposure requirements, a minimum separation distance of 0.79
inches(2cm) must be maintained between the user's body

and the back of the phone. Third-party belt-clips, holsters, and
similar accessories containing metallic components should not
be used. Body-worn accessories that cannot maintain 0.79
inches(2cm) separation distance between the user's body

and the back of the phone, and have not been tested for typical
body-worn operations may not comply with FCC RF exposure
limits and should be avoided.
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Vehicle Mounted External Antenna

(optional, if available)

A minimum separation distance of 8 inches (20cm) must be
maintained between the user/bystander and the vehicle
mounted external antenna to satisfy FCC RF exposure
requirements. For more information about RF exposure, visit
the FCC website at www.fcc.gov

FCC Part 15 Class B Compliance

This device and its accessories comply with part 15 of FCC
rules. Operation is subject to the following two conditions:

(1) This device and its accessories may not cause harmful
interference, and (2) this device and its accessories must
accept any interference received, including interference that
may cause undesired operation.

Cautions for Battery
Do not disassemble.
Do not short-circuit.
Do not expose to high temperature: 60°C (140°F).]

Do notincinerate.

For Your Safety

Battery Disposal

Please dispose of your battery properly or bring to your
local wireless carrier for recycling.

Do not dispose in fire or with hazardous or flammable
materials.

Adapter (Charger) Cautions

Using the wrong battery charger could damage your phone
and void your warranty.

The adapter or battery charger is intended for indoor use
only.

Do not expose the adapter or battery charger to direct sunlight
or use it in places with high humidity, such as the bathroom.
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KU580 Features

Parts of the phone

Open view
Earpiece
LCD screen
P Top: Icons showing signal
- strength, battery level and
Navigation keys various other functions
> In standby mode: b Bottom: Soft key
B List of Profiles indications
= Contac’Fs st Alpha numeric keys
(@ Messaging P> In standby mode: Input
IB) Calendar numbers to dial. Hold down:
P> In menu: Navigates menus. X for international calls.

EEY to dial voice mail centre.

to B for speed dials.

P In editing mode: Enter
numbers & characters.

$34n3e34 085N I
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KU580 Features
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Left soft key/ Right soft key
Performs the function indicated at the bottom of
the display.

Confirm key

Selects menu options and confirms actions.

Clear key
» Clears a character with each press. Hold
the key down to clear all input.

Send key

» Dials a phone number and answers a call.

» In standby mode: Shows a history of calls
made, received, and missed.



Left side view

Side keys a
» In standby mode (open):
Key tone volume adjustment

» In standby mode (closed):
Turns the LCD light on.

» In menu: Scrolls up & down.

» During a call: Earpiece volume
adjustment

Note

» To protect your hearing
while the slide is open,
maximum volume level is 3.

Music hot key ﬂ

> Accesses the Music menu.
Goes to MP3 player (whilst
playing music).

Micro SD memory card slot

Right side view

Headset/Charger/Cable
connector

Note

» Please ensure phone is
powered on and in idle
mode before connecting
the USB cable.

End key @
» Switch on/off (hold down)

» End or reject a call.

— Menu key B
» Opens the main menu.

» Opens the task manager
(Long press).

sa.njeay 08S N I
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KU580 Features

Rear view



How to Use Touch Keys

) This product’s keys on the slide are touch keys.

) Be sure to read “Cautions for Touch Keys” before using touch keys.

Cautions for Touch Keys
1. Make sure your hands are clean and dry.

- Remove all moisture from the surface of
your hands or the touch keys in a humid
environment.

Touch key shortcut

image

Note: You can enable
this feature in the
display settings menu
[Menu #.2.1.1].

Touch keypad

2.

W

%l

You do not need to press hard on the
touch keys to make them work normally.

Do not subject the product to severe
impact, as this may damage the touch key
sensors.

. Use the tip of your finger to press exactly

on the touch key you want, being careful
not to touch the keys for other functions.

. When both the home screen and touch

key lights are off, pressing a touch key will
not turn on the home screen light. Press
and the home screen light will turn
back on(touch keys do not work when the
touch key lights are off).

. If the slide is closed and the Touch

Protection function is on, during calls the
Touch key Lock function is automatically
enabled. (For details, see “Touch Key
Status When Using Mobile Phone")

sK9y yonoj| asn 0} moH I
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6. Touch keys may not work normally if a
mobile phone case or plastic cover is
covering them. Also, touch keys may not
work normally if you are wearing gloves.

7. Keep metal and other conductive materials
away from the surface of the touch keys, as
contact with them may result in an error.

Touch Key Status When
Using Mobile Phone
When the slide is closed, to prevent

indiscreet action of the touch keys whilst
using the phone or during calls, the Touch

Protection function is automatically enabled.

(In this case, the touch keys will not work
even if they are pressed)

1. When slide is closed

- When the slide is closed, the Touch
Protection function is automatically
enabled. (Opening the slide will
automatically disable it.)

- To disable Touch Protection when the slide
is closed, press the volume key twice.

- After disabling Touch Protection, if there is
no key action for a certain duration
(3 seconds), the Touch Protection function
is enabled again.

2. During calls

- During calls, regardless of slide status, the
Touch Protection function is automatically
enabled.

- To disable the Touch Protection, press any
key except [3 .

- After disabling the Touch key Lock,
if there is no key action for a certain
duration (3 seconds), the Touch Protection
function is enabled again.

Note

» For user convenience, the touch key
image with the functions of each
touch key is shown on the home
screen when purchasing products.



Installing the USIM card
and battery
1. Installing the USIM card.

Your USIM card contains your phone number,
service details and contacts and must be
inserted into your handset. If your USIM card
is removed then your handset becomes
unusable (except for emergency calls) until a
valid one is inserted. Always disconnect the
charger and other accessories from your
handset before inserting and removing your
USIM card. Slide the USIM card into the
USIM card holder. Make sure that the USIM
card is properly inserted and the gold

contact area on the card is facing downwards.

To remove the USIM card, press down lightly
and pull it in the reverse direction.

Getting Started

To insert the USIM card ~ To remove the USIM card

Note

» The metal contact of the USIM card can
easily be damaged by scratches. Pay
special attention to the USIM card while
handling. Follow the instructions
supplied with the USIM card.

2. Installing the battery.

Slide the battery upwards until it snaps back
into place.
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Getting Started

To remove the battery.

Turn the power off. (If the power is left on,
there is a chance you could lose the stored
telephone numbers and messages.)

Press and hold down the battery release
button and slide the battery down.

Charging the Battery

Before connecting the travel adapter to the
phone you must first install the battery.

1. With the arrow facing you as shown in the
diagram push the plug on the battery

adapter into the socket on the left side of
the phone until it clicks into place.

2. Connect the other end of the travel
adapter to the mains socket.

Note
» Only use the charger included in the box.

3. The moving bars on the battery icon will
stop after charging is complete.

4. Ensure the battery is fully charged before
using the phone for the first time.

CAUTION!

Do not force the connector as this may
damage the phone and/or the travel adapter.

o If you use the battery pack charger when
abroad, use an attachment plug adaptor for
the proper configuration.

® Do not remove your battery or the USIM
card while charging.



WARNING!

® Unplug the power cord and charger during
lightning storms to avoid electric shock or

fire.

® Make sure that no sharp-edged items such as
animal teeth or nails, come into contact with
the battery.
This may cause a fire.

Disconnecting the
charger

Disconnect the travel adapter from the
phone as shown in the diagram below.

How to use a microSD
memory card

Samisk

iCro
1ze M2

<MicroSD memory card>

<How to insert a microSD memory card>

1. Turn the phone off. Inserting or removing
the microSD when the phone is on may
damage the files stored in the memory
card.

2. Lift the plastic cover which protects the
microSD slot.

21
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3. Insert the memory card into the slot.
The gold contacts must be kept on the
back of the microSD. Don't push the
microSD too much. If it doesn't go into
the slot easily, you may be trying to insert
it in the wrong way or there could be a
foreign object in the slot.

4. Once inserted, push the memory card until
you hear a Click, meaning that the
microSD has been correctly engaged.

5. Close the plastic slot protection.

6. To remove the memory card, turn the
phone off, open the slot protection and
push the microSD to unlock it. Carefully
extract the memory card.

Attention:

» Avoid using the Flash Memory Card when
the battery is low.

» When writing to the card, wait for the
operation to complete before removing
the card.

» The card is designed to fit easily into the
system one way only.

» Do not bend the card or force it into the slot.

» Do not insert any memory cards other
than those made by microSD.

» If the microSD has been formatted using
FAT32, format the microSD using FAT16
again.

For more information on the microSD, please
refer to the memory card instruction manual.

Memory card formatting

Before you start to use the memory card you
have to format it. After you insert the
memory card, select Menu — Settings
Phone settings > Memory status
Format external memory, then press @.



This operation should only be done when
you insert the memory card for the first time.
During formatting various folders will be
created for different data types.

Turning the handset

on/of

Turning your handset on

Ensure that your USIM card is in your
handset and the battery is charged. Press and
hold |§ until the power comes on. Enter the
USIM PIN code that was supplied with your
USIM card if the PIN code request is set to
On. (Note: Please refer to page 79)

After a few seconds you will be registered on
the network.

Turning your handset off

Press and hold B until the power goes off.
There may be a few seconds delay while the
handset powers down.

Do not turn the handset on again during this
time.

Access codes

You can use the access codes described in
this section to avoid unauthorised use of your
phone. The access codes (except the PUK
and PUK2 codes) can be changed by using
the Change codes feature [Menu #.1.4.3].

PIN code (4 to 8 digits)

The PIN (Personal Identification Number)
code protects your USIM card against
unauthorised use. The PIN code is usually
supplied with the USIM card. When the PIN
code request is set to On, your phone will
request the PIN code every time it is
switched on. When the PIN code request is
set to Off, your phone connects to the
network directly without the PIN code.

PIN2 code (4 to 8 digits)

The PIN2 code, supplied with some USIM
cards, is required to access functions such as
Fixed dial number. These functions are only
available if supported by your USIM card.

papiels Suipan I
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Getting Started

PUK code (4 to 8 digits)

The PUK (PIN Unblocking Key) code is
required to unblock a blocked PIN code. The
PUK code may be supplied with the USIM
card. If not, contact your network operator’s
customer service department for the code. If
you lose the code, contact your network
operator’s customer service department.

PUK2 code (4 to 8 digits)

The PUK2 code, supplied with some USIM
cards, is required to unblock a blocked PIN2
code. If you lose the code, contact your
network operator’s customer service
department.

Security code (4 to 8
digits)

The security code prevents unauthorised use
of your phone. The default security code is
set to ‘0000’ and the security code is
required to delete all phone entries and to
restore the handset to the factory settings.

Display information

No USIM idle screen

This is the initial screen of the phone that
appears when there is no USIM card installed
in the phone, or the installed USIM card is
invalid. In this screen, users can only make
emergency calls, and turn the phone off. To
turn the phone off, press and hold down [§
for a few seconds.

Screen structure

If there is no USIM card installed, an
animation telling you to insert a USIM card
appears. If the USIM card inserted into the
phone is invalid, an animation telling you that
the USIM card is locked appears.

Emergency call function

The right soft key is represented by
“Emergency” on the screen. Press the right
soft key or dial your emergency number
using the number keys, and then press @ to
make an emergency call.



Idle screen

The idle screen appears when you have
installed a proper USIM card and turned the
phone on.

Screen structure

Idle screen consists of the operator’s name,
indicators, date and time on a background
image. You can change the wallpaper in the
Display settings menu.

Numbering screen

The numbering screen appears when a
number key is pressed in the idle screen.

Screen structure

The numbering screen consists of status
indicators, dialled number and soft menu.
Status indicators are the same as those of
the idle screen. You can change the size and
colour of the dialling font in the Display
settings menu. You can make a call while
dialling a phone number by pressing Il

Soft key

You can use the soft keys for several
functions while dialling a number. Using the
left soft key, you can make a video call, send
a message to the number, save the number to
Contacts, search contacts.

Handset lock screen

When the Handset lock function is selected,
you can only make an emergency call, release
the lock, and turn off the phone in this
screen. As always, you can turn the phone off
by pressing and holding |3 for a few
seconds.

Screen structure

The screen structure of the Handset lock
screen is the same as that of the idle screen,
except that the lock message appears on the
idle screen.

Emergency call function

You can make an emergency call using the
right soft key. As with the No USIM idle
screen, only emergency numbers can be
dialled.

papiels Suipan I
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Getting Started

Unlock function hear the information message that the call is

If you press @ key except right soft key and not connected because of the call barring.

number key, a popup screec appears asking
you to input the Security code to unlock the
phone. The Security code is configured in the
Change codes (#. Settings > 1. Phone
settings — 5. Security — 3. Change
codes). If you key in an incorrect Security
Code, the phone will remain in Handset lock
status. If you key in the correct Security
code, the phone will be unlocked, and the
idle screen will be displayed. If you have
turned the phone off in the Handset lock
status, you will find the phone remains in
Handset lock status when you turn it on.

Barring password

This service obstructs calling service in some
conditions. This condition can be edited
using the Call barring feature (#. Settings >
5. Call settings > 2. Call barring). The barring
password is required when you use the call
barring function. The password is obtained
from your network operator’s customer
service when you subscribe to this service.
While this service is activated, the caller will



Making and answering calls

Making a voice call

1. Enter the number including the full area
code.

» To delete a digit press 3.
To delete all digits press and hold [EB.

2. Press to make the call.

3. Press 13 to finish the call, or close the
handset.

Note

» To activate the speakerphone during a
call, activate the touch keys and press

Making a call from the call logs

1. In standby mode, press and the latest
incoming, outgoing and missed phone
numbers will be displayed.

2. Select the desired number by using € /
2

3. Press I to call the number.

General Functions

Making a video call

You can make a video call in a 3G covered
service area. If the called user has a 3G video
phone in a 3G covered service area, the call
will be established. You can also answer a
video call for video incoming call. To
make/answer a video call, do the following.

1. Input the phone number using the keypad,
or select the phone number from the calls
made/received lists.

» To correct mistakes, press briefly
to delete the last number, or press and
hold BB to delete all numbers.

2. If you do not want to use the
speakerphone, ensure you have the
headset plugged in.

W

. To start the video function, press the left
soft key [Options] and select Make video
call.

» You will be notified that you will need
to close other applications to make the
video call.

suoljdung |eiausn I
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General Functions

Note

» The video call may take some time to
connect. Please be patient. The
connection time will also depend on how
quickly the other party answers the call.
While the video call is connecting, you
will see your own image; after the other
party has answered, their image will be
displayed on the screen.

4. Adjust the camera position if necessary.

5. Press 13 to finish the call, or close the
handset.

Making a voice/video call from
Contacts

It is easy to call anyone whose number you
have stored in your Contacts.

1. Press ¥ to access the contacts list.
2. Scroll to the contact to make a call.

3. Press to make a voice call. Press the
left soft key and select Make video call to
make a video call.

4. Press [§ to finish the call.

Making international calls

1. Press and hold B2 for the international
prefix. The “+ character prefixes the
international access code.

2. Enter the country code, area code, and
the phone number.

3. Press .

Adjusting the volume

During a call, if you want to adjust the
earpiece volume, use a on the left side of
the phone. In idle mode, you can adjust the
key volume using a

Answering a call

When you receive a call, the phone rings and
the flashing phone icon appears on the
screen. If the caller can be identified, the
caller’'s phone number (or name if stored in
your Contacts) is displayed.



_

. Open the slider to answer an incoming
call.
Note

» To reject an incoming call, press |3 or
the right soft key twice.

» If you set Answer mode as Press send
key (Menu #.5.0.4), you can answer
the call by pressing &l after opening
the slider.

» If the answer mode is set to Press any
key, any key will answer a call except for
B.
2. End the call by closing the handset or
pressing [3 .

Note

» You can answer a call while using the
Contacts or other menu features.

» When the compatible headset is
connected, you can also answer a call
using the headset key, as well as using
the phone. To reject an incoming call,
press [§ .

» You can mute the ringtone when a call
comes in by pressing and holding the
volume down side key.

Shortcut to activate vibrate
mode

You can activate the vibrate only mode by
pressing and holding down B3 after
opening the phone.

Signal strength

You can check the strength of your signal by
the signal indicator ( gl ) on the LCD
screen of your phone. Signal strength can
vary, particularly inside buildings. Moving
close to a window may improve reception.

Entering text

You can enter alphanumeric characters

using the keypad.

For example, storing names in Contacts,
writing a message, creating a personal
greeting or scheduling events in the calendar
all require entering text.

The following text input methods are
available with the handset.
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T9 mode

This mode lets you enter words with only
one keystroke per letter. Each key on the
keypad has more than one letter. The T9
mode automatically compares your
keystrokes with an internal dictionary to
determine the correct word, thus requiring
far fewer keystrokes than the traditional
ABC mode. This is sometimes known as
predictive text. If you press # key, you
can activate or cancel T9 mode.

ABC mode

This mode lets you enter letters by
pressing the key labelled with the required
letter once, twice, three or four times until
the letter is displayed.

123 mode (Number mode)

Type numbers using one keystroke per
number.

Changing the text input mode

1. When you are in a field that allows
characters to be entered, you will notice
the text input mode indicator in the upper
right corner of the LCD screen.

2.1f T9 is on, you can change the mode to
T9Abc, TO9ABC, 123, T9ab by pressing
B . When T9 is off, the mode will be
changed to Abc, ABC, 123, abc.

Using the T9 Mode

The T9 predictive text input mode allows you
to enter words easily with a minimum number
of key presses. As you press each key, the
handset begins to display the characters that
it thinks you are typing based on a built-in
dictionary. As new letters are added, the word
changes to reflect the most likely candidate
from the dictionary.

1. When you are in the T9 predictive text
input mode, start entering a word by
pressing to B3, Press one key per
letter.



» The word changes as letters are typed.
Ignore what's on the screen until the
word is typed completely.

» If the word is still incorrect after typing
completely, press == once or more to
scroll through the other word options.

Example
Press tm 2 B3 B3 to type Good.
Press & to get Home.

» If the desired word is missing from the
word choices list, add it by using the
ABC mode.

2. Enter the whole word before editing or
deleting any keystrokes.

3. Complete each word with a space by
pressing .
To delete letters, press [EB. Press and hold

down to erase
entire words.

Using the ABC Mode
Use I3 to g to enter your text.

1. Press the key labelled with the required
letter:

» Once for the first letter.
» Twice for the second letter.
» And so on.

2. To insert a space, press EEB once. To
delete letters, press B press and hold
down B 1o clear the display.

Refer to the following table for more
information on the characters available using
the alphanumeric keys.

suoljdunyg |esausn I
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Characters in the order display
Key Lower case Upper case
By .20 1-()@/:_[.21 “1-()@/:_|
E=N |abc2aaaaaazc (ABC2AAAAAAEC
¥ |def3eéee DEF3EEEE
By (ghidiiii GHI41ITT
Em |jki5e JKL5¢
3 mno6hoododddooe MNO6NDODDOOOE
Bz |pqrs78S$ PQRS7B$
= (tuv8ulUll Tuvsuuuu
3 (wxyz9 WXYZ9
™ | Space, 0 Space, 0
Note

» The characters assigned to the keys and
their order of appearance depends on
the language selected using the option
Input method. The table above provides
the characters set for English language.

Using the 123 (Number) mode

The 123 mode enables you to enter numbers
in a message(a telephone number, for
example). Press the keys corresponding to
the required digits before manually switching
back to the appropriate text entry mode.

Using the symbol mode

The symbol mode enables you to enter
various symbols or special characters. To
enter a symbol, select Options — Insert >
Symbol. Use the navigation and numeric keys
to select the desired symbol and press @ .



Overview of Menu Functions

You can launch a menu by pressing @ in the idle screen. Move to the desired item and
press @ to go into the sub menu.

From the main menu you can also go into a submenu by directly pressing the corresponding
numeric key as follows. The main menu consists of the following top menus and sub menus.

i,

2.

¢

Entertainment

1.7 Games & Applications
1.2 Mobile TV

Vodafone live!

2.1 Homepage

2.2 Enter URL

2.3 Bookmarks

2.4 Saved pages
2.5 History

2.6 Browser settings

Music

3.1 Now playing

3.2 Recently played
3.3 My music

3.4 Radio DJ

3.5 FM radio

3.6 My wishlist

3.7 Music store

3.8 Song recognition

4.

v

&

Camera

4.1 Camera
4.2 Video recorder

. Messaging

5.1 Create new

5.2 Inbox

5.3 Drafts

5.4 Outbox

5.5 Sent Items

5.6 Email

5.7 Templates

5.8 Emoticons

5.9 live! Studio

5.0 Messaging settings

My Files

6.1 Pictures

6.2 Sounds

6.3 Videos

6.4 Games & Applications
6.5 Others

6.6 External memory

7. Organiser & Tools
7.1 Quick menu
7.2 Alarms
7.3 Calendar
7.4 Tasks
7.5 Memo
7.6 Voice recorder
7.8 Calculator
7.9 Converter
7.0 World time

&2

Contacts

8.1 Add new

8.2 Contacts list

8.3 Groups

8.4 Speed dials

8.5 Service dial numbers
8.6 Own number

8.7 My business card
8.8 Settings

9. Calls
9.1 All calls
9.2 Dialled calls
9.3 Received calls
9.4 Missed calls

%. USIM Tool Kit
/Alarms(if SAT not
supported by USIM)

0. Video Call

#. Settings
#.1 Profile
#.2 Phone settings
#.3 Display settings
#.4 Call settings
#.5 Messaging settings
#.6 Contact settings
#.6 Connectivity
#.7 Java settings

SUO0IdUN4 NUIN JO MIIAIBAQ I
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Entertainment [Menu 1]

Games & Applications

Menu 1.1

You can easily download games and other
applications in this menu. It has two folders,
Games and Applications, as default. Each
folder has an embedded link for downloading
games or applications. Please note that
additional costs may be incurred when using
online services. You can create a folder using
the left soft key [Options].

Mobile TV Menu 1.2

You can access Mobile TV by selecting this
menu.



Vodafone live! [Menu 2]

Homepage Menu 2.1
You can launch the web browser and access
the homepage of the web service provided

by Vodafone.

» You can also directly access Vodafone live!
by pressing the right soft key in idle mode.

Enter URL

Menu 2.2

Enter address (Menu 2.2.1)

You can manually enter a URL address and
access the associated web page.

» To enter a symbol, press & or press the
left soft key [Options] and select 1.Insert
symbol from Options menu to display the
symbol table

» To switch input mode, press 9.

Bookmarks

You can store frequently accessed or
favourite URLs/Pages. Open, Send, Add
new, Edit, Mark/Unmark or Delete

Menu 2.3

operations can be performed on Bookmarks.
Several preconfigured URLs are stored as
bookmarks.

Adding a new bookmark
1. Press the left soft key [Options] and
select 2.Add new from Options menu.

2. Enter the title and associated URL
information.

3. Press @ to save.

Connecting to a desired bookmark
Press @ to connect a desired bookmark.

Sending the bookmark to others

Select Send from Options menu. You can
send it via Message or Email.

Deleting a bookmark

Select Delete from Options menu. You can
delete multiple bookmarks using the
Mark/Unmark option.

Editing a bookmark

Select Delete from Options menu. Edit the
title and associated URL information. Press
@ to save.
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Vodafone live!

Menu 2.4

Saved pages

The phone can save the page on display as
an offline file. Up to 20 pages can be saved.

Menu 2.5

History

You can view the list of the pages you've
already connected.

Browser settings  menu 256

You can change the settings for browser

connectivity, display, security, and certificates.

Profiles (Menu 2.6.1)

Select the appropriate profile by pressing
@ . This will activate the profile to initiate
the browser launch.

Character encoding (Menu 2.62)

Sets the browser default character set to one
of the following:
Automatic, English(ASCII), English(ISO),
English(LATIN), Unicode(UCS2 BE),

Unicode(UCS2 LE), Unicode(UCS2 Auto),
Unicode(UTF-16 BE), Unicode(UTF-16
LE), Unicode(UTF-16 Auto), Unicode(UTF-
8).

Scrolling control (Menu 2.6.3)

Allows you to set the scroll speed by
selecting the number of lines to scroll.
Select one from 1 line, 2 lines, 3 lines.

Show image (Menu 2.6.4)
Allows you to enable or disable the image
display during browsing.

Note

Enabling this function will delay displaying
images until the completion of
transmission. Disabling this function will
prevent the browser from downloading
images from the server, thus allowing faster
transmission.



Cache (Menu 2.6.6)

Enabling Cache allows you to store accessed
pages to your phone. Once a page has been
stored in the Cache it will greatly enhance
the page loading speed on subsequent
browsing of the same page.

Cookie (Menu 2.6.7)

Enabling Cookie allows you to store cookies
sent from the server. Disabling this function
will prevent cookies from being stored on
your phone.

JavaScript (Menu 2.6.8)
Select whether to turn JavaScript On or Off.

Reset setting (Menu 2.6.9)

Select this to reset your phone to its default
browser configuration.

Security (Menu 2.6.2)

Certificates

If stored, a list of root/ca certificates required
for WTLS/TLS can be found here.
Certificates can be viewed from the list.

[9A1] SUOJBPOA I

Session clear

Secure (WTLS/TLS) session data can be
cleared using this option. Session data
should be cleared to establish a new secure
session.

Ringtones
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Music [Menu 3]

Now playing
This menu will be activated when there are
some tracks currently played.

Menu 3.1

Menu 3.2

Recently played

This menu allows to show the 20 lists of
music which is played recently.

Menu 3.3

My music

All tracks

You can view the entire music files in the
phone/external memory.

(Menu 3.3.1)

Playlists (Menu 3.3.2)

You can create your own playlists by

choosing tracks from the All tracks menu list.

Artists

You can view and play musics which are
sorted by Artists.

(Menu 3.3.3)

Albums

You can view and play musics which are
sorted by Albums.

(Menu 3.3.4)

Genres (Menu 3.3.5)

You can view and play musics which are
sorted by Genres.

Shuffle tracks

If you want to play the music continuously
and randomly, select this menu.

(Menu 3.3.6)

Radio D)

This menu enables you to listen to either
pre-set radio stations or personalised
channels with play lists.

Menu 3.4

To use the Radio D) menu, the following
requirements must be met:

» The radio station and the network service
must support this service.



My channels (Menu 3.4.1)

The customer creates a new personal channel
by selecting specific criteria. Whilst listening
to a channel a customer can rate tracks and
turn a pre-defined channel into a personal
channel.

RDJ channels

RD) channels are created based on detailed
criteria by content experts in the Back Office
and are NOT limited to a number of tracks.

(Menu 3.4.2)

RD) Compilations (Menu 3.4.3)

RDJ Compilations are arranged by the
Content Team in the back office but are
compiled out of a FIXED number of tracks.

My Account (Menu 3.4.4)

You can check the account for each channel.

FM radio

Menu 3.5

Title Descriptions

FM frequency and channel number which
is now playing

Frequency

Radio station | Radio station information

Volume Controlling the volume

Channel

Setting the channel

If you press options, you can view the menus
as follow:

» Edit channel: You can edit the selected
channel.

» Auto scan: You can search the channel by
scanning automatically.

» Reset channels: You can reset the
channels.

» Listen via: You can listen the FM radio via
speaker or headset.
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— My wishlist Menu 3.6

When listening to Radio D), the user is able
to add a track to their wishlist to mark it for
later purchase and download.

dISN

Music store Menu 3.7
Connects to the Vodafone music download
site.

Note

Additional charges may be incurred when
downloading music.

Contact your service provider for further
information.

Song recognition Menu 3.8

Selecting this menu starts dialling a number
for song recognition. For further information,
please contact your service provider.
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Camera [Menu 4]

Camera Menu 4.1

This application enables you to take a still picture. You can take a picture in the size you want,
and use it for the address book photo, home screen and other more general purposes.
Once taken, the picture can be sent by Message, Postcard, Email or Bluetooth.

BISWED) I

Brightness : From 2.0 to Zoom: x1, x2 (Note:
2.0 at 0.5 intervals. L l Available zoom level
The higher the level, the E. ©90 ol depends on the size.)

» You can zoom in with
8@/ zoom out with &8
in preview mode.

brighter the screen.

» You can adjust the
brightness using H
preview mode.

Opti  Take ) Back

Press @ to take a picture.

1. Press the left soft key to access Options and set the desired environment as follows.
» Move between the options menus with -/ e .
» Select the desired value with (8l / JB) and confirm the selection with @.
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Menu Description Menu Description
Go to The Pictures folder is launched and WB You can adjust the tone of the
displays existing pictures as thumbnails. background photo according to the
You can view pictures by pressing @. weather. X .
You can also send the selected picture to Auto, Daylight, Cloudy, llluminate,
another party via Message, Postcard, Indoors
Email or Bluetooth. Night mode | You can take better pictures at night by
selecting On.
Size ]63(())0:18200(0 (I 32]0282339(60 ( Frame Shot You can apply one of 10 frame effects
X X - .
' when taking a picture.
‘é/a”'t)aptezﬁﬁiﬂ)' 176x144 (available only in case of Wallpaper size)
ontact (=
Quality Super fine ([EH), fine (IE), Timer You can delay the camera shutter time.
Standard ) None, 3 secs., 5secs., 10 secs.
Multishot One, Three (&), Six (&), Nine (&) ‘ @ " is shown when the timer is
(Note: Available Burst shot depends on activated.
the size) Effect None, Black & White, Negative, Sepia
Zoom x1 (@), x2 (@) (Note: Available Sound Select the desired shutter sound.
zoom level depends on the size.) | h red th
» You can zoom in with il / zoom out Memory Select the desired memory, either
with @ in preview mode. Handset or External.
Brightness From -2.0 to 2.0 at 0.5 intervals. The Mirror You can activate the mirror effect by
higher the level, the brighter the screen. selecting On.
Swap cam You can switch the camera to activate

either the Internal or the External
camera.




2. After finishing all the settings, press the right soft key [Close].
3. Focus the camera on what you want to take and press @ .
4. Press @ to save the picture. It is saved in the Pictures folder of My Files.

Note

Press the right soft key [Back] to go back to the preview mode without
saving the picture.
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Video recorder Menu 4.2

This application enables you to record a video clip. You can play and watch a saved video file in
this menu. Once recorded, a video clip can be sent by Message, Email or Bluetooth.

Brightness : From -2.0 to Zoom: x1, x2 (Note:

2.0 at 0.5 intervals. L l Available zoom level

The higher the level, the depends on the size.)

brighter the screen. » You can zoom in with

» You can adjust the B/ zoom out with &
brightness using in preview mode.
preview mode.

Press the @ to record the image.

1. Press the left soft key to access Options and set the desired environment as follows.

» Move between the options menus with (il / JB) .
» Select the desired value with i / = and confirm the selection with @ .



Menu Description Menu Description

Go to The Videos folder is launched and displays WB You can adjust the tone of the background
existing videos as thumbnails. video according to the weather.
You can view videos by pressing @. You Auto, Daylight, Cloudy, llluminate, Indoors|
can also send the selected video to
another party via Message, Email or Night mode | You can take better shots at night by
Bluetooth. selecting On.

Size 320x240 (4 ), 176x144 ( Effect None, Black & White, Negative, Sepia
128x96 (Kl Duration Select the desired recording time.

Quality Message, 30 secs., 1min, 2mins., 5mins.,

60 mins.
Zoom X1 (@), <2 (@52), 4 (@) (Note: Memory Select the desired memory, either Handset
) . or External.

Available zoom level depends on the size.)
» You can zoom in with il / zoom out Mirror You can activate the mirror effect by
with ®B in preview mode. selecting On.

Brightness | From —2.0 to 2.0 at 0.5 intervals. The Mute Decide whether to record the sound or
higher the level, the brighter the screen. not.

Swap cam You can switch the camera to activate

either Internal or External.
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BN ) After finishing all the settings, press the right soft key [Close].
3. Focus the camera on what to record and press @ to start recording.
And press @ to stop recording.
» You can pause the recording by pressing the right soft key [Pause].
4. Press @ to save the video clip. It is saved in the Videos folder of My Files.

elawe)

Note
Press the right soft key [Back] to go back to the preview mode without

saving the video clip.
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Create new Menu 5.1

Message (Menu 5.1.1)

You can write and edit a message containing
a combination of text, image, video and
audio.

1. Enter your message in the Message field.
Option menus in Message field

» Insert: You can perform the following
actions:

1. Image: You can insert an image.
(Existing image/New taken picture)

2. Video: You can insert a video clip.
(One video clip per slide)

3. Sound: You can insert a sound file.
(One sound per slide)

4. Symbols: You can insert symbols.
After entering the corresponding
number keys, press @ .

5. Template: You can insert a text
template saved on the phone. After
selecting one, press @ . The selected

Messaging [Menu 5]

template is inserted into the Message
window.

6. Emoticon: You can insert a emoticon
on writing a message,

7. Name & number: After searching the
name and the number in phonebook,
you can insert the entry.

8. New slide: Select this to add a new
slide.

9. Subject: Select this to insert a
subject.

) Save to drafts: Select this to save the
message to drafts.

» Input method: Select the desired
dictionary mode.

» Writing languages: You can select the
language for writing a message.

» Add to dictionary: You can add a word
to the dictionary.

2. Press the right soft key [Back] to exit the

menu or go to previous menu after setting
submenus.
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. Press the confirmation key [Send] to send
the message. The message will
automatically be saved in the Sent Items
folder. If the message has not been sent, it
will remain in the Outbox with a failed
status.

Email (Menu 5.1.2)

To send/receive an email, you should set up
the email account. (Refer to page 54-56 for
how to set up an Email account.)

1. Enter the email addresses of the recipients
in the To, Cc, Bcc fields. You can search
the Contacts by pressing @ .

Note

o Enter the reference email address to
forward the email in Cc(Carbon copy)
field.

* Enter a hidden reference email address to
forward the email without forwarding
information in Bcc(Blind Carbon Copy)
field.

48

® Only valid email addresses are allowed for
the recipient (To), reference address (Cc)
and hidden reference address (BCC)
fields. When an email address has been
specified, another field where you can
specify another address appears. You can
specify up to 20 recipients for the To
and Cc address fields and 10 recipients
for the BCC address field.

2. Move the cursor to the Subject field and
key in the subject.

3. You can enter the message contents by
moving the cursor to the Message field.

4. Use the following functions by using the
left soft key [Options].

» Insert: Select this menu to insert special
characters, templates, and contacts. It is
also possible to attach multimedia files
(pictures, videos and sounds).

» Search contacts: Select this menu to
insert email addresses saved in
Contacts. (Only shown in Option menu
when cursor is located in To/Cc/Bcc

fields.)



» Recently used: You can use the latest
email address you saved temporarily.

» Save to drafts: Select this menu to save
the message in Drafts.

» View attachment: Shows the attached
files. (This item is only available when
some files have been attached.)

» Remove: Deletes the attachment file.

» Input method: Select the desired
dictionary mode.

» Add to dictionary: You can add a new
word to the dictionary.

» Writing language: You can change the
writing language.

» Set mail priority: You can configure the
priority of the email you wish to send.

5. When you have finished writing an email,
press @ to send the email.

Postcard (Menu 5.1.3)
(Note: This service is not available in all countries. Please
contact your service provider for further information.)

1. Enter the Postcard menu.

2. Press the left soft key [Insert picture]. You
can insert a stored image or newly taken
picture. If you press the right soft key, you
can go back to previous menu.

W

. After an image is inserted, the format will
be changed to Postcard format by
pressing the confirmation key.

4. Fill out the fields: Name, Additional info,
Address, Post code, City, State, Country.

5. Press the confirmation [Send] to send the
created postcard.

Voice messages

You can send voice message after recording
it.

(Menu 5.1.4)

1. Enter the voice message menu.

2. Press the confirmation key to record your
voice message.
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3. Press the confirmation key to stop the
recording. For sending the message
directly, press the confirmation key once
again.

4. If you want to preview the message or save
it to drafts, press the left soft key
[Options].

Inbox

1. You can view saved messages. Select a
message and then press @ to view the
message.

Menu 5.2

N

. You can view the previous or next message
by using (& / 1)

. To view a multimedia message
(Notification), select Retrieve in the
message notification view screen. Then the
file is transmitted, and you can view the file
when the transmission is complete.

W

You can use the following functions by using
the left soft key [Options] in the Inbox.

» Reply: Creates a reply to the sender or
all recipients of the selected message.

>

>

Forward: Forwards the selected
message.

Note

Not supported for multimedia message
(Notification) and WAP push messages.

Make video call: You can make a video
call.

Delete: Deletes the current message.

Create new message: You can write a
new message or an Email.

Copy: In case of SMS, you can copy the
message into handset or USIM.

Move: In case of SMS, you can move
the message into handset or USIM.

Filter: Displays messages by desired
message types.

Mark/Unmark: You can select one or
more messages for multiple deletion.

Message info.: You can check the
message type, date and time and where
it is saved.



Note

You can check the saved Emails in Email
[Menu 5.6].

Drafts

You can view saved messages. Select a
message and then press @ to edit the
message.

You can use the following functions by using
the left soft key [Options].

» Send:

Menu 5.3

» Delete: Deletes the selected message.

» Create new message: You can write a new
message or an Email.

» Filter: Displays messages by desired
message types.

» Message info.: You can check the
message type, date and time and where
it's saved.

Outbox

The Outbox is a temporary storage place for
messages waiting to be sent. Failed messages
are also placed in Outbox. For example,
Emails will be placed in Outbox if the Email
account is not correctly configured.

Menu 5.4

1. Select a message and then press @ to
view the message.

2. You can use the following functions by
using the left soft key [Options].

[For sending / waiting messages] & /&%

» Create new message: You can write a new
message or an Email.

» Cancel: You can stop sending/waiting
status.

» Message info.: You can check the
message type, date and time and where
it's saved.

[For sending a failed message] &%
» Resend: Resends the selected message.

» Delete: Deletes the current message.
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Messaging

> Save to drafts: You can send the message
to drafts.

» Create new message: You can write a new
message or an Email.

» Message info.: You can check the message
type, date and time and where it's saved.

Sent [tems

Shows the messages you sent (Message/

Postcard/ Email).

[Options]

» Reply: Creates a reply to sender or all
recipients of the selected message.

Menu 5.5

» Forward: Forwards the selected message.
» Edit: You can edit the selected message.
» Delete: Deletes the current message.

» Create new message: You can write a new
message.

» Copy: In case of SMS, you can copy the
message into handset or USIM.

» Move: In case of SMS, you can move the
message into handset or USIM.

» Mark/Unmark: You can select one or
more messages for multiple deletion.

» Filter: Displays messages by desired
message types.

» Message info.: You can check the message
type, date and time and where it is saved.

Email

Viewing email message list

Menu 5.6

1. Select an email account and then press
@ to view the received email list.

2. Using the right soft key [Retrieve], you
can retrieve a new email list from the email
server of the selected account.

3. In email list, you can use the following
functions by using the left soft key
[Options].

» Reply to: Creates a reply to the
selected email.



» Forward: Forwards the selected email
message to others.

» Retrieve: Retrieves new email messages.

» Search: You can search the email you
want to find out.

» Delete: Deletes the email.

» Create new message: Creates a new
message or Email.

» Mark/Unmark: Use mark/unmark
option for multiple deletion.

» Set as read/unread: You can set the
selected email to read or unread.

» Sort by: You can sort email according
to the conditions.

» Message info.: Brief information on the
message including size, type, date, time
and filenames.

Viewing an email message

1. Select one of the received emails and
press the View key to receive the contents
of the email.

2. The contents of the received email are
automatically displayed in the View screen.

3. You can view the contents of the previous
or next email by using (- ¥2 -}

4. In the email View screen, you can select
the following functions by using the left
soft key [Options].

» Reply to: Creates a reply to the
selected email.

» Forward: Forwards the selected email
message to others.

» Delete: Deletes the email.

» Save address: Saves the sender’s
address to Contacts.

» Create new message: Creates a new
message.

» Extract: Extracts the number, email
address or Web address from email
message.

» View attachment: Shows the attached
file.

» View recipients: Shows the email
addresses of the recipients and
reference (Cc).
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» Message info.: Brief information on the
message including size, type, date, time
and filenames.

Templates Menu 5.7

Text templates (Menu 5.71)

You can add, edit, and delete frequently
used useful phrases using the left soft key
[Options].

Note

Depending on your service provider, useful
phrases are saved as a default.

Multimedia templates  (Menu 5.72)

You can create, edit and view available
templates when creating multimedia
messages. Five types of template (Birthday,
Greeting, Holiday, Thanks, Sorry) are saved
by default.

The following options are available.

» Add new: You can create a new multimedia
template.

» Write multimedia message: Creates
a multimedia message with the selected
template.

» Edit: Edits the selected template.

» Delete: Deletes the selected template.
(Not available for default five templates)

» Delete all: Deletes all templates. This
menu is not available for default templates.

Emoticons

You can add, edit and delete emoticons. You
can insert the emoticon which you preferred
on writing a message. If you press
confirmation key, you can view the icon.

Menu 5.8

|IV€' Stud|o Menu 5.9

(Note: This service is not available in all countries. Please
contact your service provider for further information.)

Accesses the remote media album.

Messaging settings

Menu 5.0



Text message (Menu 5.0.1)

You can configure text message related

options.

1. Text message centre: Input the address
of the Text message centre.

2. Delivery report: By enabling this option,
you can verify whether your message has
been sent successfully.

W

. Validity period: This network service
allows you to set how long your text
messages will be stored at the message
centre.

4. Message types: Text, Voice, Fax, X.400,
Email

Usually, the type of message is set to Text.

You can convert your text into alternative
formats. Contact your service provider for
the availability of this function.

v

. Character encoding: Auto/ Default
alphabet/ Unicode.

» Auto(default): Message with single
byte character is normally encoded in
Default alphabet(GSM7). Message with

double-byte character is automatically
encoded in unicode(UCS2).

» Default alphabet: Message with even
double byte character is encoded in
single byte. Please note that double
byte characters with accent may be
converted into single byte character
without accent.

» Unicode: Message is encoded in
double byte. Please note that you may
be charged double.

6. Send long text as: Select a long text
message as Multiple SMS or MMS.

Multimedia message ~ (Menu5.02)

You can configure Multimedia message
related options.

1. Retrieval mode: You can set the retrieval
mode using Home network and Roaming
network respectively. If you select
Automatic, you will receive multimedia
messages automatically. If you select
Manual, you will only receive a notification
message in the inbox and then you can
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decide whether to download multimedia
messages or not.

. Delivery report: Allows you to determine

whether to request a delivery confirmation
mail to a recipient, and whether to allow
sending a delivery confirmation mail to a
sender.

» Request report: Determines whether to
request a delivery confirmation mail for a
Multimedia message.

» Allow report: Determines whether to
allow sending a delivery confirmation
mail for a delivery confirmation mail
request.

. Read reply: Allows you to determine

whether to request a read confirmation
mail to a recipient, and whether to allow
sending a read confirmation mail to a
sender.

» Request reply: Determines whether to
request a read confirmation mail for a
Multimedia message.

» Allow reply: Determines whether to
allow sending a read confirmation mail
for a read confirmation mail request.

4. Priority: You can select the priority level
of the messages (Low, Normal and High).

5. Validity period: Allows you to configure
the term of validity for a message when
transmitting a multimedia message. The
message would be saved in the multimedia
message server only for the configured
term.

6. Slide duration: Allows you to configure
the duration of each page when writing a
message.

7. Creation mode: Allows to select the
contents type supported by MMS.
(Free,Warning and Restriced)

8. Delivery time: Configures the delivery
time of message to the recipient. The
Multimedia message centre will deliver the
message after the delivery time.



9. Multi. msg. centre: Allows you to
configure network information such as the
MMSC and the WAP gateway, to send a
multimedia message.

Using the left soft key [Options], you can
activate, add or delete a profile. A profile
name selected by a checkmark is the
currently configured value. You can view
and edit the contents of the profile in edit
mode by pressing the right soft key [Edit].
The edit screen also appears when
creating a new profile under Options. The
meaning of each item is given below.

» Title: Profile name.

» MMSC URL: Enter the multimedia
message centre URL.

» MMS Proxy: Enter the WAP gateway
address and port number.

» Connection mode: Select one of the
connection mode. (TCP with Proxy, TCP
without Proxy, UDP)

» Access points: Specify the access point
name. (see WAP connection settings.)

Press the right soft key [Done] to save the
changes and complete Multimedia msg.
centre setting.

E-mail (Menu 5.0.3)

You can configure settings for receiving and
transmitting emails.

1. Vodafone Mail: Access to Vodafone Mail.
(Note: This service is not available in all countries.
Please contact your service provider for further
information.)

2. Email accounts: You can create or
configure an email account including the
email server and user ID. You can edit a
selected email account by pressing the left
soft key[option]- 2.Edit. You can select an
email account to be used to send an email
using @ You can select the following

functions using the left soft key [Options].

» Add new: Create a new email account.

» Edit: To edit the selected email
account.

» Delete: Deletes a selected email
account. All the emails included in the
account will be deleted.
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3. Allow reply email: Determines whether to
allow sending a read confirmation mail for
a read confirmation mail request.

4. Request reply email: Determines whether
to request a read confirmation mail.

5. Retrieve interval: You can configure
Retrieve interval to retrieve emails
automatically from the incoming mail
server. When a new email arrives, an icon
appears at the top of the screen. You can
select the auto receiving time slot to
Off,15 minutes, 30 minmutes,1 hour.2
hour,4 hour or 8 hour.

Please note that additional charges may
be incurred using the Retrieve interval
feature.

6. Include original message: Determines
whether to include the original message
when you forward the message or reply to
it.

7. Include attachment: Determines whether
to include the attachment file when you
forward the message or reply to it.

8. Auto retrieval in roaming:

9. Download option: You can set the
configuration of downloading the
contents.

10. New email noti. info:

11. Signature: You can configure a text
signature to be attached to the end of an
email. The configured signature text is
automatically or manually attached to the
end of the email when it is sent.

12. Priority: You can select the priority level
of Emails (Low, Normal and High).

Creating a new email account

1. Select Add new from the Email account
menu options.

2. The following items need to be configured.

Title Enter a title.

Enter the user name of the email
account.

Username

Password Enter the email account password.

Email address Enter the email address for outgoing

mail.
Reply email Enter the email address to reply to
address your email.
Outgoing mail | Enter the outgoing email server.

server




Incoming mail Enter the incoming email server.
server

SMTP port Enter the mail server port number. In
number general, the SMTP (Outgoing mail

server port number) is 25.

Incoming server
port

Maximum receive
size

Enter the mail server port number. In
general, the incoming mail server port
number is 110(POP3) or 143 (IMAP4).

Select the maximum email receive size

SMTP Decide whether the outgoing mail I

authentication | server to require authentication or not
using @ When the SMTP
authentication is set to On, you can
enter the SMTP Username and SMTP
Password for SMTP authentication.

APOP secure Decide whether to activate APOP
login secure login or not using @. When
the mailbox type is IMAP4, APOP
secure login is always set to OFF.

using @. The permissible
receive size is no more than 1MB.

Mailbox type

Select the email inbox type either
POP3 or IMAP4 using @

Save to server

Determine whether to leave a copy of
messages on the incoming server or
not using &, When the mailbox type
is set to IMAP4, a copy of messages
are always saved to the server.

Save sent mail
into

Select where to save the sent mails
(when the mailbox type is set to
IMAP4). When the mailbox type is
POP3, sent mails are always saved into
handset.

Access points

Select an access point to connect to
the Internet. You can select a
configured access point using @ .

Auto retrieve

Decide whether to activate Auto
retrieve or not using . You can set
the auto receiving time slot using the
Auto retrieve [Menu 5.9.3.4].

(See page 54.)

3. Press the center soft key [Save] to
complete the email account configuration.

Editing an email account

1. Select a desired email account from the
email account list and press the left soft
key[option]- 2.Edit.

2. You can edit desired fields by moving the
cursor up and down.

W

When configuration is complete, press the
center soft key [Save] to complete the
email account configuration.

Note

When you try to change the mailbox
type, all emails downloaded before
would be deleted.
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Info. service (Menu 5.0.4)

» Cell broadcast: You can set the reception
status.

» Channels: You can add or modify the
channels.

» Languages: You can select the language
you want by pressing @ . Then, the info
service message will be shown in the
language that you have selected.

Service message (Menu 5.0.5)

You can configure the service message
receipt option.



Pictures

The Pictures folder consists of embedded
links for downloading pictures through the
Internet and Default images.

Pictures taken using the camera are stored in
the Pictures folder and you can create new
folders to manage them. Yo can also send
multiple files to other people.

Menu 6.1

To view the picture in details, press the
confirmation key.

When a file is selected, the following options

will be displayed by pressing the left soft key

[Options].

» Send: You can send the selected image via
Message, Postcard, Email or Bluetooth.

» Use as

- Main wallpaper: You can set an image as
the home screen theme.

- Contacts image: You can set the image
of selected entry in contacts. When
incoming a call, the image saved in
contact is displayed.

- Start up: You can set an image as shut
up screen theme.

My Files [Menu 6]

- Shut down: You can set an image as shut
down image.

» Move: Enables the file to be moved to
other folder.

» Copy: Enables the file to be copied to
other folder.

» Delete: Deletes the selected image.

» Mark/Unmark: Using the Mark function,
you can send, delete, move and copy
multiple files.

» File
- Rename: You can rename the image.
- Edit: Enables the image to be edited.

- File info.: Shows information on the
selected image file.

» Create new folder: You can create a new
folder within the folder currently selected.

» Sort by: You can sort the files by date, file
type or name.

» List view/Grid view: You can view the
images as a List view or Grid view.

» Memory status: You can view the memory
status(handset or external memory card).
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Menu 6.2

The Sounds folder consists of embedded
links for downloading ringtones and music as
well as folders containing the Default sounds
and Voice recordings. Here you can manage,
send or set sounds as ringtones.

When a file is selected, the following options
will be displayed by pressing the left soft key
[Options].
» Use as

- Voice ringtone: You can set the sound

file as a ringtone when incoming a voice
call.

- Video ringtone: You can set the sound
file as a ringtone when incoming a video
call.

- Message tone: You can set the sound file
as a ringtone when receiving a message.

- Start up: You can set the sound file as a
ringtone when handset starts up.

- Shut down: You can set the sound file as
a ringtone when handset shut down.

» Sort by: You can sort the files by date, file
type or name.

» File info.: Shows the information on the
selected sound file.

» Memory status: You can view the memory
status(handset or external memory card).

Videos

Here you can manage or send downloaded or
captured videos clips.

Menu 6.3

If you press @ [Connect], you can activate
the video file.

The following are available using the left soft
key [Options] in the Video list.

» Send: You can send the selected video clip
via Message, Email , Bluetooth or media
album if not protected by Digital Rights
Management (DRM).

» Use as: You can set the video file as voice
ringtone or video ringtone.

» Move: Moves the file into handset memory
or external memory.



» Copy: Copies the file in handset memory
or external memory.

» Delete: Deletes the selected video.

» Mark/Unmark: Using the Mark function,
you can send, delete, move and copy
multiple files.

» File
- Rename: You can rename the video.

- Info.: Shows information on the selected
video file.

» Create new folder: You can create a new
folder.

» Sort by: You can sort files by name, date,
or file type.

» List view/Grid view: Displays the video
files as a List view or Crid view.

» Memory status: Displays the memory
status(handset or external memory card).

You can view a video using the video player.
Video files are displayed in the list as
thumbnails. You can select a desired video by
using the i / €8/ ([ / JB) . Select a
desired video and select Play to view the
recorded video.

Select the right soft key [Send] to attach the
selected video to a message, Email or
Bluetooth.

When option 1. Play is selected, the video
clip will be played with the Media Player. To
pause the playback, press @ during the
playback. To resume the paused playback,
press @ once again.

To capture the screen shot, press the right
soft key [Capture] when the playback is
paused.

To view the current playback in full screen,
press the right soft key during the playback.

To return to the previous screen size, press
the right soft key once again in full screen
mode.

When viewing video clips in the Media Player,
the following options are available:
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» Pause/Play: You can play or pause playing
a file for a moment.

» Send: You can send the video via
Message, Email or Bluetooth if the file is
not protected by Digital Rights
Management (DRM).

» Go to list: Goes back to the list.

» Delete: Deletes the selected video.

» Sound theme: You can set a video as the
voice ringtone or video ringtone.

» Wide view: You can view the video in wide
view mode.

» Mute/Unmute: If the Volume is set to
more than 0, Mute mode is activated and
if the Volume is set to 0, the Unmute
mode is activated.

» Capture: You can save what is on the
paused screen as an image file (only
possible in Pause mode).

» Set repeat: You can set the repeat option
(None/Current file/All files).

» Move to
- Previous file: Plays the previous video file.
- Next file: Plays the next video file.

» File info.: You can check information on
files being played(File name, Size, Date,
Type, Duration, Protection).

Games & Applications wenu 6.4

You can easily download games and other
applications in this menu. It has two folders,
Games and Applications, as default. Each
folder has an embedded link for downloading
games or applications. Please note that
additional cost may be incurred when using
online services. You can create a folder using
the left soft key [Options].

Others

Other files except pictures, sounds, videos,
games & applications are stored in this
folder.

Menu 6.5



External memory  wens 6.6

If you purchase an optional external microSD

memory card, you can manage more content.

Refer to the section How to use a microSD
memory card on page 21 and 22 to learn
how to insert and remove the memory card.
You can manage content as you do on your
phone.

a4 AW I
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Quick menu

You can specify functions to save in the
Quick menu. If you save the functions
frequently used in the Quick menu, you can
quickly start the functions simply by pressing
key.

Menu 7.1

Alarms

If you set the alarm, the B appears on the
indicator bar. The specified alarm sounds at
the scheduled time. Press @ to stop the
alarm, and the alarm is released. Press the
right soft key [Snooze] and choose the
snooze interval. The alarm sound stops and
resumes after the selected Snooze duration.
You can configure up to 5 alarms.

Menu 7.2

1. Select your desired alarm to configure in
the alarm list. If there is no alarm, press
the right soft key [Add] to add a new
alarm.

N

. Set/Cancel alarm: Set or cancel the
alarm using the options for specifying
whether the alarm is on or by choosing
the alarm time.

Organiser & Tools [Menu 7]

W

. Input alarm time: Input your desired
alarm time by specifying Hour and Minute.
Choose either ‘AM’ or ‘PM’ which is visible
if 12 hour format is specified for the
phone.

4. Select repeat mode: Select the desired
repeat mode using (@l / M) or select the
desired one from the list by pressing right
soft key [List].

Select bell: Select the bell to ring at the
alarm time opening the list by pressing left
soft key [Edit].

6. Input memo: Input alarm name.

v

7. Snooze: You can set the snooze duration
for the alarm.

8. When you have finished setting the alarm,
press the center key [Save].

Note

The alarm will go off even when the phone
is switched off.



Calendar Menu 7.3

Schedule inquiry and search

1. Reference by Months

You can refer to your schedule by months.
The cursor is on the current date, and the
registered date is marked.

The schedule saved for the date where the
cursor is located is represented by an icon.

W

and alarm set up configuration are
displayed. You can send the schedule to
another phone or an Internet site through
SMS(Text message) or MMS(Multimidia
message) or Email or Bluetooth.

. Detailed reference

You can refer to a detailed schedule, that
is the whole contents of the schedule
configured by the user. You can send the

schedule to another phone or an Internet
site through SMS(Text message) or
MMS(Multimidia message) or Email or
Bluetooth using the left soft key
[Options].

Add schedule

You can add a schedule. You can configure
the start date, end date, start time, end time,
contents, type of schedule, repetition, alarm
of the schedule.

Pressing the shortcut key ™8 moves to
the previous year and pressing =8 move
to the next year and pressing B8 moves
to today. Pressing ™8 moves to the
previous month, and B moves to the
next month. Pressing &8 moves to the
weekly calendar, and g8 moves to the
monthly calendar. You can move the date

using i /€2 / (@ /1B

2. Reference by Days
Pressing @ in the reference by month
moves to reference by day where you can
refer to your schedule by days. You can
refer to the moving date tab using (@ /
B . As a search result, brief schedule
contents, repetition set up configuration,

» Set type: Appointment, Anniversary,
Birthday

» Set repeat: Once, Daily, Weekly, Monthly,
Annually, User setting
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» Set alarm: No alarm, On time, 15 mins
before, 30 mins before, 1 hour before, 1
day before, 3 days before, T week before

Delete schedule

1. Delete elapsed schedules
You can delete all elapsed schedules using
this function.

2. Delete all
You can delete all saved schedule contents
using this function.

Set up and release holiday

You can set up or release user holidays. Press the
left soft key [Options] and select Set holiday.
The selected date will be displayed in red.

To release the holiday, press the left soft key
[Options] and select Clear holiday.

Schedule notification

If the user has configured the alarm setting,
the specified alarm sound will ring. If the
notification time is before the schedule start
time, you can set up the alarm again.

Tasks

You can view, edit and add tasks to do. Tasks
are displayed in time order. Tasks that have
been completed or not completed are
displayed in different ways.

Add

To add a task, press the right soft key
[Options] in the Tasks list management
screen and select the add new event option.
Then input the date, description and priority
for the task.

When you have finished entering the data,
press the center key [Save] to save the new
task.

Menu 7.4

Detailed view and Edit

To view detailed task contents, locate the
cursor on the desired item in the Tasks list,
and then press @ . You can edit and delete a
task using the left soft key [Options]. You
can also delete multiple or all tasks at once
using the Mark/Unmark option.



Set job status

Tasks set as finished are displayed as crossed
out below the unfinished tasks in the Tasks
list. You can set Finished tasks to Not
finished by selecting Option.

Memo

Using the memo management function, you
can view and manage saved memo contents,
and add new memo.

Add memo

To add a new memo, press the left soft key
[Add] or [Options]. Enter the contents of
the memo. You can save the memo to the list
by pressing the center key [Save].

Menu 7.5

Edit and delete memo

Highlight the desired memo and press @ to
view its contents. You can edit or delete the
contents of a memo using the left soft key
[Options]. You can return to the memo
management screen by pressing right soft
key [Back]. You can select Multiple or All
memos using the Mark/Unmark option and
then delete a memo using the Delete option.

Voice recorder

1. Press the left soft key [Option] to display
the option pop up menu before recording,

Menu 7.6

2. Move to the desired menu item using SR
/"B and press @ .

» Duration: You can set the recording
duration to MMS msg. size, 30 secs, or 1
min.

» Quality: You can select a recording
quality from Super Fine, Fine and
Normal.

» Go to my sounds: Opens the Voice
recordings folder in My Files.

3. Pressing @ starts recording. When a
recording is started, the recording time
appears on the LCD. To cancel the
recording, press the Back.
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4. When you finish the recording, press @
to exit. The recorded file is automatically
saved in the Voice recordings folder in My
files.

5. When no recording is in progress, pressing
@ starts recording on a new file.

Select one from Message, Email, or
Bluetooth using i@ / ® and press @.

6. Press the left soft key to select the various
options after the voice recording.

7. Select the desired menu using i / L -
and press @

» Play: You can play the voice.

» Send: To send the recorded file. Select
one from Message, Email and Bluetooth
using i / & and press @.

» File: You can change the name of file
and view the information.

» Delete: Select this menu to delete a
recorded file.

» Use as: You can set the recorded file as
the Voice Ringtone, Video Ringtone.

» Go to my sounds: Opens the Voice
recordings folder in My Files.

8. Press the right soft key to close the
sub-menu popup window.

Calculator

The calculator module allows you to
perform basic arithmetic functions such as
addition, subtraction, multiplication, and
division as well as some scientific functions.
(sin, cos, tan, log, In, exp, sqrt, deg, rad)

1. Press the left soft key [Options].

Menu 7.8

2. Select the appropriate function.

You can enter numbers by using the number
keys, and the operators by using i / €& ,
(@ /3. You can enter a decimal point by
pressing EB3 . Whenever you press [EB,
characters are sequentially deleted in reverse
order. Whenever you hold down, all the
characters are deleted in reverse order in one

go.



When calculation is complete and the result
is displayed on the screen, pressing a number
clears the previous result and the calculator
waits for new input, even if you did not press
the right soft key [AC]. When calculation is
complete and the result is displayed on the
screen, pressing a symbol saves the result
into the symbol, and continues calculation.

Converter

Using this menu, users can convert Currency,
Surface, Length, Weight, Temperature,
Volume and Velocity.

Menu 7.9

Currency (Menu 79.1)

1. Select the Currency menu.

2. Users can set a currency exchange rate
using option menu "Change currency”.

3. Enter currency rates for up to 6 currencies
equivalent to GBP and then press [Save].
Then you can convert from one currency
to another.

4. You can view the value of up to 6 currency
units.

5. Press [Reset] to clear the current input
Field.

6. To exit the currency conversion function,
press the [Back] key.

Surface (Menu 79.2)
1. Select Surface menu.

2. Select the desired unit to convert using
[List].

3. Enter the standard unit and view the
converted value.

4. Press [Reset] to clear the current input
Field, and locate the cursor in the input
field.

5. To exit the Surface conversion function,
press [Back] key.

Length
1. Select the length menu.

(Menu 7.9.3)

2. Select the desired unit to convert using
[List].

3. Enter the standard unit and view your
converted value.
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4. Press [Reset] to clear the current input

field and locate the cursor in the input
field.

5. To exit the length conversion function,
press the [Back] key.

Weight
1. Select the Weight menu.

(Menu 7.9.4)

2. Select the desired unit to convert using
[List].

3. Enter the standard unit and view the
converted value.

4. Press [Reset] to clear the current input Field,
and locate the cursor in the input field.

5. To exit the Weight conversion function,
press the [Back] key.

Temperature (Menu 79.5)
1. Select the Temperature menu.

2. Position the cursor on the desired unit by
using the up or down arrow keys.

3. Enter the standard unit and view the
converted value.

4. Press [Reset] to clear the current input
field and locate the cursor in the input
field.

5. To exit the Temperature conversion
function, press the [Back] key.

6. You can insert negative values by selecting

[

Volume (Menu 7.9.6)

1. Select the Volume menu.

2. Select the desired unit to convert using
[List].

3. Enter the standard unit and view the
converted value.

4. Press [Reset] to clear the current input
field and locate the cursor in the input
field.

5. To exit the volume conversion function,
press the [Back] key.



Velocity
1. Select the Velocity menu.

(Menu 7.9.7)

2. Select the desired unit to convert using
[List].

3. Enter the standard unit and view the
converted value.

4. Press [Reset] to clear the current input
field and locate the cursor in the input
field.

5. To exit the Velocity conversion function,
press the [Back] key.

World time

The World clock function provides time

information on major cities worldwide.

1. You can select a desired city as a base
using the left soft key Options - Add
city or Options — Add city > Map.

Menu 7.0

2. You can Change the city using the left soft

key Options = Change city or Change
current city.

3. You can apply to Daylight Saving time
using the left soft key Options — Daylight
saving.

4. You can Select the Analog clock mode
Options — Analog clock.

sjoo] % 43siuediQ I
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Contacts [Menu 8]

Add new

You can register a new contact address. You
can enter the name, different phone numbers
and email addresses of a new contact. You
can also assign the contact to groups,
include an image or avatar, assign a specific
ringtone and even enter a memo for the
contact. Other available fields include Home
page URL, Home address, Company name,
Job title and company address. You can enter
and manage contact addresses depending on
the memory usage.

Menu 8.1

Contacts list

Performs the contact address search
function. The search operation is performed
based on a name as a default. The current
search method and results found are
displayed in the Search window. You can
make a phone call or send a message to the
selected phone number. A Contacts search
can be performed based on the phone
number or group information.

Menu 8.2

Groups

Using this menu you can manage group
information (both stored in the Handset and
the USIM). In the handset memory, there are
4 default groups: Family, Friends, Colleagues
and School. You can add, edit and delete
groups. When a ringtone for a number is not
specified, a call from the number sounds the
group ringtone assigned to the number for
the group.

Menu 8.3

Menu 8.4

Speed dials

Using this menu you can manage speed dials.
Speed dials are configured between 2-9. You
can register speed dials for a specific contact
address up to 5 different numbers, and a
contact address may have multiple speed
dials.

Service dial numbers

You can view the list of Service Dialling
Numbers (SDN) assigned by your service
provider (if supported by the USIM card).

Menu 8.5



Such numbers include emergency, directory
enquiries and voice mail numbers. After
selecting a service number, press to dial
the service.

Own number

Allows you to display your phone number in
the USIM card. You can save own numbers
being used in the USIM card.

Menu 8.6

My business card  wenss

You can create your own business card by
pressing the left soft key Add. After entering
the name, number, email and image, you can
use it as a business card when sending the
message.

Menu 8.8

Settings

View contacts from (Menu 8.8.1)

Select which contact information shall be
displayed (from handset memory, from USIM
card or both). All is the default setting.

Show image/avatar ~ (Menygsz)
(R

Select whether to display image/avatar or S

not. %’f

Copy all (Menu 8.8.3)

You can copy contacts from the phone
memory to the USIM or from the USIM to
the phone memory. You can copy all items or
one at a time.

Move all (Menu 8.8.4)

You can move contacts from the phone
memory to the USIM or from the USIM to
the phone memory. You can move all items or
one at a time.

Clear contacts (Menu 8.8.5)

Clears all contact information. You can delete
all contacts saved in the mobile phone
memory as well as on the USIM card.

/5
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Calls [Menu 9]

You can check the record of missed, received,
and dialled calls only if the network supports
Calling Line Identification (CLI) within the
service area.

The number and name (if available) are
displayed together with the date and time at
which the call was made. You can also view
call times.

All calls

Allows you to view the missed, received, and
dialled call records. You can make a call, or
send a message to the number you have
selected from the records. You can also save
the number in Contacts.

Menu 9.1

Dialled calls

Menu 9.2

Allows you to view dialled call records, make a

call, send a message, and save the number in
Contacts.

Received calls

Allows you to view received call records, make
a call, send a message, and save the number
in Contacts.

Menu 9.3

Missed calls

Allows you to view missed call records, make
a call, send a message, and save the number
in Contacts.

Menu 9.4



USIM Tool Kit [Menu *]

Depending on whether you have SAT support
services or not (i.e. USIM Application Toolkit)
on the USIM card, this menu (Menu %) may
be different.

If the USIM card supports SAT services, this
menu will be the operator-specific service
name stored on the USIM card, for instance
“Special”. Please refer in that case to the
information provided with your USIM card
for further information on how to use the
related options.

If the USIM card does not support SAT
services, this menu will be Alarms.

For the Alarms menu feature, please refer to
page 63.

1001 ISN I
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Video call [Menu 0]

You can make a video call using this menu.
1. Enter the number you want to dial.
» You can key in the number.

» You can select the number from Search
contacts using the left soft key
[Options]

» You can find the number from call logs
by pressing @ [Video call].

2. Press the ceter key [Video call] or [Send]
to make a video call.

During a video call

When you are in a video call, the screen will
show the contact’s name and duration of call,
contact’s image, volume indicator, video
control panel, and your image.

You can access the following option menus
by pressing the left soft key [Options].

» Mute/Unmute
» Speaker (On /Off)

» Bluetooth/Handset talk (When the
Bluetooth headset is connected)

» Hold/Resume

» Capture

» View sender number
» Go to contacts

» Go to messages

» Settings

» End call

Incoming video call

When a video call is received, the caller’s
information is displayed as following.

» Picture/Animation: Displays picture ID,
graphic image configured in Contacts, or
default animation indicating the incoming
call.

» Caller's name and number: Shows
incoming caller's number. If the number is
stored in Contacts, displays the name of
the contacts.

Picture ID and animation setting is used in
the order of Contacts, video file used in
Group ringtone, and video file used in Profile.



Also, sound can be set for the incoming
video call. The sound setting is used in the
order of Contacts, Group ringtone, and
Profile.

You can accept the incoming call by pressing
the center key [Accept]. Also you can accept
the incomming call and show the private
image by pressing the left soft key [Private].

The incoming call ringing can be silenced by
pressing the right soft key [Silent]. It can be
also silenced by long press on @ on the left
side of the phone.

When ringing is silenced, press the right soft
key [Reject] to reject the call.
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Settings [Menu #]

Menu #.1

You can select ringtone or vibration for an
incoming call and configure the sound and
volume of the ringtone, key tone, and sound
effect, according to a profile. The profiles
provided include [Normal], [Silent], [Vibrate
only], [Outdoor], [Headset], [Customised
1], [Customised 2], and [Customised 3].
Select a profile, and press @ to activate the
profile. After pressing the left soft key
[Options], select the Edit menu for the
[Normal], [Outdoor], [Headset],
[Customised 1], [Customised 2] and
[Customised 3] profile to change the
configuration. A different list of options is
available for each profile that has been
selected for editing.

» Alert by
This option determines the incoming call
notification mode. You can select from
[Ring], [Vibration], [Silent], [Ring &
vibration], [Ring after vibration], [Max Ring
& Vibration].

» Voice ringtone
You can select the ringtone for incoming
voice calls.

» Video ringtone
You can select the ringtone for incoming
video calls.

» Volumel
Set the ringtone volume.

» Message alert
You can set how often the phone is to
inform you of a received message until it is
read.

» Message tone
You can select a file from among your own
personal files or from the default files, to
be played by the phone upon receiving a
message.

» Key tone
You can set the key tone to be played
when pressing the keys.

» Key tone volume
You can set the volume of the chosen key
tone, choosing from 7 available levels.



» Slide tone
Select the desired tone the phone will emit
when you slide up/down the phone.

» Confirmation tone
You can set the confirmation tone to be
played by the phone to confirm actions.

» Start up sound
You can set the effect to be played when
the phone is switched on.

» Select start up sound
You can select which file will be played
when the phone is switched on.

» Power off sound
You can set the effect to be played when
the phone is switched off.

» Select power off sound
You can select which file will be played
when the phone is switched off.

Phone settings

Menu #.2

Date & time

Although the current time is automatically
configured when the phone is registered to
the network, users can configure the time
and date directly using this menu. The time
configured by the user is valid only while the
phone is turned on.

(Menu #.2.1)

Time
1. Select the Time item from the Date &
time list, and then press 0.

2. Move to your desired field, Hour, Minute,
or am/pm field using the navigation keys.
(When you have selected 12 hour as Time
format)

3. Enter Hour, and Minutes using the
number keys.

4. Select the time format using (- 2 -}

5. Scroll down to select the hour indicator
format i.e. Off, Cuckoo clock or Chime
bell.
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Settings

6. Press the right soft key [Done] to set the
time with the specified value.

Date

1. Select the Date item from the Date &
time list, and then press 0.

2. Select the date format using (- 92 - B

3. Enter Day, Month and Year using the
number keys.

4. Press the right soft key [Done] to set the
date with the specified value.

Auto update date/time

When Auto Update is configured to On, the
time and date are automatically updated
according to the current time zone. If
Confirm first is selected, the time and date
update is confirmed before it is updated
automatically.

Daylight saving

Select whether to activate the daylight saving
function or not. You can set the Summer
time difference of selected home city for 1
hour or 2 hours.

Language
Select the display language. You can select
Automatic language option to change
display language to the USIM card supported
language.

(Menu #.2.2)

Auto key lock

If you activate this function, the keypad will
be locked automatically in standby mode
without requesting the action of key.

(Menu #.2.3)

Flight mode

If you acivate the Flight mode, you can use
the phone without connecting the 3G
wireless network. 3G wireless phone and FM
radio signals from the phone or Bluetooth
connections are prevented, but you can still
do tasks which do not require the use of
wireless network. With flight mode you
cannot make any calls including emergency
calls or use other features that require
network service.

(Menu #.2.4)



Security (Menu #2.5)  Handset lock
You can lock your phone. The following 4

PIN cod t . .
coce reques lock functions are available.

When this is set to On, you are requested to

enter your PIN each time you switch the When switching on: Locks the handset
phone on. whenever the handset is switched on.
Not If USIM changed: Locks the handset when
ote the phone’s USIM card has been changed.
» Press the right soft key in the PIN code . ) )
entry window to return to the previous Immediate: Locks the handset immediately.
step.

None: Deactivates the lock function.

» 3 incorrect PIN code entries would .
invalidate the PIN code. And you have to You are requested to enter the security code
enter the PUK (PIN Unblock Key) code to confirm the selection.

B e R N R » To unlock the handset, you need to enter

» The maximum number of times you may th ity code.
enter the PUK code is 10. (Note: If you e security code
enter an incorrect PUK code 10 times,
the USIM card will be blocked and must Change codes
be replaced.) You can change the PIN, PIN2, and the

» If the PIN code request cannot be mobile phone password.

disabled by operator settings, you will

not be able to choose this menu item. PIN code
PIN is the abbreviation for Personal
|dentification Number, and is used to restrict

use by an unauthorised user.
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PIN code change procedure

1. Select ‘PIN code’ from the ‘Change codes’
list and then press @ .

2. Enter the current PIN code, and press Q.

3. Enter the new PIN code, and press Q.

4. Enter the new PIN code once again, and
press @ .

» If the PIN code is different from that of
step 3, the procedure is restarted from
step 3.

5. When the PIN code is changed properly, a
Changed message is displayed. If you
enter an incorrect PIN code in step 2, the
procedure is restarted from step 2, and
the number of attempts you have left to
enter the number decreased by 1.

6. Press the right soft key in the PIN code
entry window to return to the previous
step.

Note

» Three incorrect PIN code entries in the
PIN code entry window would invalidate
the PIN code. In this case, you have to
enter the PUK (PIN Unblock Key) code
to configure the PIN code again. The
maximum number of times you may
enter the PUK code is 10. (Note: If you
enter an incorrect PUK code10 times,
the USIM card will be blocked and must
be replaced.)

PIN2 code

PIN2 is the abbreviation for Personal
Identification Number 2, and is used to
restrict use by unauthorised users as with the
PIN. The PIN2 code change procedure is the
same as the one for the PIN code. 3
incorrect PIN2 code entries would invalidate
the PIN2 code. In this case, you have to
enter the PUK2 code in order to use the
PIN2 code again. The maximum number of
times you may try to enter the PUK2 code is
10, like PUK1. 10 incorrect PUK2 code
entries would invalidate the PIN2 code.



Security code

The security code is used to change the
mobile phone password. The maximum
number of attempts to enter the security

code is not limited as it is with PIN and PIN2.

Auto key lock

If you select Off, the keypad can be
activated only when the slide is open. If you
select On, you can activate the keypad by
pressing a on the left side of the phone.

Power save (Menu #.2.6)

Decide whether to activate the power save
mode or not.

Memory status (Menu #.2.7)

Common memory

This function shows the status of the user
memory of the mobile phone. Since this
function scans the overall file system for
statistics, a few seconds are required.

Reserved memory

This function shows the status of the User
reserved memory. The usual contents are
Text messages, Contacts, Calendar, Tasks,
Memo. And it gives a clear illustration of the
actual amount compared with the total
amount for each item.

s3umas I

USIM memory

This function shows the status of the USIM
card user memory.

External memory

This function shows the status of the
External card user memory. This function
displays the In-use and free memory usage
statistics.

Primary storage setting (Menu #.2.8)

You can select the storage to download the
file: Handset memory or External memory.
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Settings

Handset Information  (Menu #.2.9)
This functions shows the USIM card
telephone number, model name and software
version of the mobile phone.

Reset settings (Menu #.2.10)

Select this to reset your phone to its default

configuration. You are requested to enter the
security code.

Display settings ~ wenu #.3
This menu allows you to personalise the
display options of the screens and of the
menus entire graphic interface.
Main Display (Menu #.3.1)
You can set the screen theme to be displayed
on the main screen.

Home screen

» Wallpaper: You can select an image to be
displayed on the main screen.

» Homescreen items: You can select which
items to display on the screen: Calendar +
Clock, Calendar, Clock, Clock + Key guide,
Dual clock, Key guide or Do not show.

» Clock type: You can select the type of
clock.

» Clock font colour: You can select the
colour of displaying the clock.

Outgoing call picture

You can select the image to be displayed
while dialling a number.

Start up picture

You can select the image to be displayed
while the phone is being switched on.

Power off picture

You can select the image to be displayed
while the phone is being switched off.

Menu style (Menu #.3.2)

You can select the desired menu style from
Grid style and One by one style.



Font

You can set the font style, dialling font size,
and dialling font colour using (- 2 -}

(Menu #.3.3)

Backlight

You can set the backlight duration and the
brightness on the Home screen and the
duration on the Keypad. individually.

(Menu #.3.4)

Welcome message (Menu #.3.5)

After selecting On, you can write a welcome
message.

Call settings

Menu #.4

Call durations (Menu #.4.1)

You can view call time by types. Press the left
soft key [Options] to choose either partial
initialisation or entire initialisation. Also press
right soft key [Clear] to initialise a selected
duration type. Initialization will require your
Security code.

The following timers are available:

» Last call: Shows the latest call time in
units of hours/minutes/seconds.

» Received calls: Shows incoming call time.
» Dialled calls: Shows outgoing call time.

» All calls: Shows total call time.

Call barring (Menu #.4.2)

Call barring menus for Voice and Video calls
are provided.

The menu consists of Voice calls, Video calls
and Deactivate all. The Voice calls and Video
calls menus have the following submenus.

The Call barring menu consists of All
outgoing, Outgoing international,
Outgoing international calls except home
country, All incoming and Incoming when
abroad submenus.

The All outgoing menu bars dialling all
outgoing calls, the Outgoing international
menu bars dialling outgoing international
calls, and the Outgoing international calls
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except home country menu bars dialling

outgoing international calls except for the
Home PLMN country. All incoming rejects
all incoming calls and the Incoming when
abroad menu rejects incoming calls when

roaming.

Voice calls

Video calls
All outgoing

1. When @ is selected, it receives the
Barring password from user, and activates
the barring service on the network. A
requesting message and animation
appears. When the network answers, the
result of the operation is displayed.

2. When the Options menu is selected, it
activates the Outgoing calls menu. Select
the Options menu from the soft menus on
the lowest menu. Then Deactivate,
Deactivate all, View status and Change
password menus appear.

The Deactivate menu deactivates the
barring service after the user's Barring

password is entered. The Deactivate all
menu deactivates all barring services
configured in the network after the user’s
Barring password has been entered. The
View status menu enables users to view
the current network configuration.
Selecting View status menu displays the
Requesting message with animation and
the result of the operation when the
network answers. Change password menu
enables users to change the current
barring password.

Outgoing international

1. When @ is selected, it operates in the
same way as the Outgoing calls menu.

2. When the Options menu is selected, it
activates and operates the International
calls menu. It operates in the same way as
the Outgoing calls menu.

Outgoing international calls except home
country

1. When @ is selected, it operates in the
same way as the Outgoing calls menu.



2. When the Options menu is selected - It
activates and operates the International
except home country menu. It operates
in the same way as the Outgoing calls
menu.

All incoming

1. When @ is selected, it operates in the
same way as the Outgoing calls menu.

2. When the Options menu is selected, it
activates and operates the Incoming calls
menu. It operates in the same way as the
Outgoing calls menu.

Incoming when abroad

1. When @ is selected, it operates in the
same way as the Outgoing calls menu.

2. When the Options menu is selected, it
activates and operates the Incoming calls
when abroad menu. It operates in the
same way as the Outgoing calls menu.

Fixed dial numbers (Menu #.4.3)
» FDN ON/OFF: Select whether to activate

FDN or not. PIN authentication is required.

» FDN List: Displays the current FDN list.
You can edit, add, or delete fixed dial
numbers. PIN2 authentication is required
to edit the list. And the configuration
information is saved on the USIM. The
information saved on the USIM is used
when FDN restricts outgoing calls.

Data volume (Menu #.4.4)

Allows you to check the sent, received and all
data volume transferred.

Press the left soft key [Options] to choose
for partial initialization or entire initialization.
You can also use the right soft key [Clear]
for the initialization of the selected volume
type. Initialization will require your Security
code.

Call costs (Menu #.4.5)

1. This function displays the call costs of the
Last call and All calls.

2. To initialise, press the center key [Clear]
and enter the PIN2 code.
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W

. You can select either Units or Currency in
Set call cost. According to your setting,
the call cost is displayed during a call (If
USIM and Network support Advice Of
Charge(AOC)).

4. In the Set limit configuration, select On

to configure the cost limit. When a cost

limit is configured, and the call costs reach
the limit, making a call will not be allowed.

Diverts (Menu #.4.6)

Call divert menus for voice and video calls
are provided.

If you press @, you can activate call divert

menu.

Voice calls

All voice calls
When busy
No answer

Not reachable

1. When the number list is not exsisted
Converts to an editor for entering a divert
number. You can input the number to
divert a call directly or search it in
phonebook. If you press @ [Divert], the
phone will send the request to service
provider after entering the number. While
waiting for the result from the network, a
Requesting message and animation
appears.

2. When the number list is exsisted
Displays To other number menu including
of the number list. While waiting for the
result from the network, a Requesting
message and animation appears.

3. Option menu
After activating All voice calls menu,
selecting the Options menu at the bottom
of the menus displays the Deactivate,
Deactivate all, View status and clear list
menus.
The View status menu shows the settings
on the network. If you select this menu,
Requesting. message and animation
appear. Then the network settings are



displayed when the information is received
from the network. If you select the
Deactivate menu, the call divert numbers
registered in the network are deleted after
user confirmation.

Clear list menu will delete all divert
number list.

Video calls
All video calls

1. When the number list is not exsisted
Converts to an editor for entering a divert
number. You can input the number to
divert a call directly or search it in
phonebook. If you press @ [Divert], the
phone will send the request to service
provider after entering the number. While
waiting for the result from the network, a
Requesting message and animation
appears.

2. When the number list is exsisted
Displays To other number menu including
of the number list. While waiting for the
result from the network, a Requesting
message and animation appears.

3. Option menu

After activating the All video calls menu,
selecting the Options menu at the bottom
of the menus displays the Deactivate,
Deactivate all, View status and clear list
menus.

If you select the Deactivate menu, the call
divert numbers registered in the network
are deleted after user confirmation.
Selecting the Cancel all menu will display
the operation result after showing the
Requesting message and animation. Clear
list menu will delete all divert number list.

When busy

1.

When the number list is not exsisted
It operates the same as All voice calls
menu.

. When the number list is exsisted

It operates the same as All voice calls
menu.

. When Option menu is selected

It activates and operates If busy menu. It
operates the same as All voice calls menu.
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No answer

1. When the number list is not exsisted
It operates the same as All voice calls
menu.

N

. When To a number is selected
It operates the same as All voice calls menu.

(2]

. When Option menu is selected
Activates and operates No answer menu. It
operates the same as All voice calls menu
except that users can configure delay time
in the Set waiting time menu in the menu
list.

Not reachable

1. When the number list is not exsisted
It operates the same as All voice calls
menu.

N

. When the number list is exsisted
It operates the same as All voice calls
menu.

W

. When Options menu is selected
Activates and operates If out of reach menu.
It operates the same as All voice calls menu.

Call waiting (Menu #.4.7)

» Activate: Activates waiting service.
Selecting this item, displays requesting
message and animation. When the network
answers, the result of the operation is

displayed.

» Deactivate: Deactivates Call waiting
service. Selecting this item displays
requesting message and animation. When
the network answers, the result of the
operation is displayed.

» View status: Displays activated Call waiting
service group item of the network.
Selecting this item displays requesting
message and animation. When the network
answers, the result of the operation is
displayed.

Voicemail (Menu #.4.8)

You can add or modify voice mail centre.



Video call

You can set the screen display when making
/receiving a video call.

(Menu #.4.9)

» Use private image: Determine whether to
show the private image or not.

» Select private image: Select the still
image to be displayed.

» Mirror: Select to activate the mirror effect
or not.

- On: Displays the image flipped side to
side.

- Off: Displays the image as it is.

» My image size: Select my image size to be
displayed.

» My image position: Select the position
where your image will be displayed.

Common settings (Menu #.4.0)

Call reject
You can set whether to reject incoming calls.

1. Select On in Reject menu to activate call
reject. The Reject list menu appears.

2. Set the desired call reject option in the
Reject list menu.

» All calls: Rejects all calls.

» Contacts: Rejects the calls from the
number stored in Contacts.

» Groups: You can specify call rejects by
group units stored in Contacts.

» Unregistered: Rejects calls from the
number not stored in Contacts.

» No caller ID: Reject calls which do not
have CLI information.

Send my number

» Set by network: Configures with the
default settings determined by the service
provider.
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» On: Configures to send my phone number
when making an outgoing call.

» Off: Configures not to send my phone
number when making an outgoing call.

Auto redial

Allows you to set the auto redial function
when a call attempt has failed.

Answer mode

Allows you to set the answering method. You
can choose between Press send key, Slide
up and Press any key.

Minute minder

Determines whether to sound a T minute
tone every 1 minute when you are on the
phone.

BT answer mode

» Hands-free: You can answer a call using
the Bluetooth headset, when the
Bluetooth is connected.

» Handset: If you press & on the handset
to answer a call, you can talk on the

handset. If you press the Bluetooth
headset key to answer a call, you can talk
using the Bluetooth headset.

This is the initial answer mode selection. And
while talking, you can switch from handset to
headset or from headset to handset.

Save new number

In this menu, you can save the phone number
when ending a call if the phone number is
not saved in a phonebook.

Slide close setting

when the slide is down, you can set the call is
ended or not.

Messaging settings
For detailed information, please refer to page
51.

Menu #.5

Contact settings

For detailed information, please refer to 72.
(Menu 8.7)

Menu #.6



Connectivity Menu #.7

Bluetooth (Menu #.7.1)

Bluetooth connection

Your phone has built-in Bluetooth wireless

technology which makes it possible for you
to connect your phone wirelessly to other

Bluetooth devices such as a handsfree, PC,
PDA or other phones.

You can, for example, have a conversation via
a cordless Bluetooth handsfree or browse the
Internet, wirelessly connected via a mobile
phone. You can also exchange, for example,
business cards, calendar items and pictures.

Note

» We recommend that your phone and the
Bluetooth device you are communicating
with be within a range of 10 meters. The
connection may be improved if there are
no solid objects between your phone
and the other Bluetooth device.

1. Getting started

® Menu — #. Settings — 7. Connectivity —
1. Bluetooth —> 1. Turn on/off

To use the Bluetooth function, you must first
set Turn on.

2. Configuring Bluetooth settings

® Menu > #. Settings > 7. Connectivity >
1. Bluetooth — 2. Settings

- My visibility: Set [My handset’s visibility]
to [Show to all] so that other devices can
detect your phone when they are searching
for a Bluetooth device. If you select
[Hidden], other devices will not be able to
detect your phone when they are searching
for a Bluetooth device.

- My name: You can name or rename your
phone as it will appear on other devices.
Your phone’s name will be shown on other
devices only when [My handset’s visibility]
is set to [Show to all].

- Bluetooth usage: To use the Bluetooth
function, set it to [On]. Otherwise, set it to

[Off].
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Note

» When user uses Bluetooth Device in the
handset, the security of the handset is
at risk.

Therefore, we recommend that
Bluetooth visibility be set to Hidden after
configuration or device pairing.

For incoming files via Bluetooth
regardless of paired devices, you can
choose to accept or reject the
connection, after checking the sender
details.

3. Supported services device
Pairing Devices Pairing with a device)
If a paired Bluetooth device already exists.

® Menu > #. Settings — 7. Connectivity >
1. Bluetooth — 1. Paired devices ~
Option > Add new device

If there is no paired Bluetooth device.

® Menu > #. Settings > 7. Connectivity >
1. Bluetooth — 1. Paired devices > Add
new device

Option
» Connect

1. If you want to open the connection to
the selected device, select the Connect.

2. If you want to close the connection to
the selected device, select the
Disconnect.

» Add new device: Using this menu, you can
pair a new Bluetooth device with your
phone.

» Delete: Using this menu, you can delete
the paired Bluetooth device.

» Delete all: Using this menu, you can
delete all of the paired Bluetooth devices.
<Pairing devices>
1. To search for a Bluetooth device to pair,
press Add new device .

2. Screen shows Searching for devices.
Bluetooth devices within a range of 10m
will be found.



3. If Bluetooth devices are found, these
devices are listed on the screen. If no
Bluetooth device is found, you will be
asked if you want to search again.

4. Pairing procedure

- Press @ . A window will appear on the
screen asking you to enter your
password.

- After creating a password (of 1 to 16
digits), the user of the other device
must enter the password for pairing.
The user of the other device must know
the password in advance for
authentication.

<Deleting devices>

1. Select a device to delete from the Paired
devices screen.

2. You can delete a device by pressing the
Delete key or by selecting Options >
Delete. To delete all paired devices, select
Options > Delete All.

<Transmitting data using Bluetooth>

—_

. To transmit data from your phone to
another Bluetooth device, first select the

application where the target data is saved.

For example, to send data in the My Files
to another device, select

Menu — 6. My Files > 1. Pictures /

2. Sounds / 3. Videos/ 5. Bluetooth data
/ 6. Other files / 7. External memory —
Select data to transmit > Send —> 3.
Bluetooth

2. Transmitting data

1) Last device found is displayed. If the
desired device does not exist in the
list, select [More devices].

2) Select the device to which you want
to transmit data from the devices on
the screen and press @.

3) If the other party selects [Yes] for
[Connection request], the data is
transmitted.
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<Receiving data using Bluetooth>

Menu — #. Settings — 7. Connectivity >
1. Bluetooth — 1. Paired devices

If another party attempts to transmit data,
the [Connection request] question will
appear on the screen. If you select [Yes], the
data will be transmitted to your phone.
During data transmission, the Bluetooth icon
flashes.

<Bluetooth data storage folder>

You can check the received data by selecting
Menu — 6. My Files = 5. Bluetooth data.

4. Device
<Connecting a headset>

Menu — #. Settings — 7. Connectivity >
1. Bluetooth

1. Connect the headset according to the
procedures described in the Pairing
Devices section.

2. To use the headset, select the headset
from the registered devices, press the
Option key and then select 3.Connect.

W

. To check that the selected headset has
been connected successfully, press the
Option key. If it is properly connected,
3.Disconnect will appear. If it is not
connected, 3.Connect will appear.

<Connecting a handsfree kit>

—_

.Menu — #. Settings > 7. Connectivity >
1. Bluetooth

2. Connect the handsfree kit according to
the procedures described in the Pairing
Devices section.

W

. To use the handsfree kit, select the
handsfree kit from the registered devices,
press the Option key and then select
3.Connect.

4. To check that the selected handsfree kit
has been connected successfully, press the
Option key. If it is properly connected,
3.Disconnect will appear. If it is not
connected, 3.Connect will appear.



Synchronisation (Menu #.72)

Synchronisation (Menu #.7.2)

(Note: This service is not available in all
countries. Please contact your service
provider for further information.)

If Sync service is supported by your network
operator, this service function synchronizes
the data in a phone and the data on a server
such as Contacts, Calendar, and Tasks via a
wireless network.

Connect

1. Select the Connect item and then press

2. Connect to the server with the selected
server profile and the synchronization
animation is displayed while the
synchronization is performed.

Logs

Select the Logs item and then press @ to
view the log for the last synchronization
operation performed.

Server synch. centre

1. Select the Server synch. centre item and
then press .

2. This menu allows you to configure the
profile for a synchronization server.

» Profile name: Input the name for the
profile.

» Host address: Contact your service
provider.

» SyncML proxy: Contact your service
provider.

» User name: Enter your user ID for
synchronization server.

» Password: Input your password.

» Contacts: Select whether to synchronise
Contacts or not.

» Contact name: Input the contacts
database name for server access.

» Calendar: Select whether to synchronise
Calendar or not.

» Calendar name: Input the calendar
database name for server access.
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— » Tasks: Select whether to synchronise - Restore

Tasks or not. The server sends all its data from a
database to the phone. The phone is
expected to replace all data in the

target database with the server sent by
» Memo: Select whether to synchronise the server. This means the server

Memo or not.

» Tasks name: Input the Tasks database
name for server access.

overwrites all data in the phone

» Memo name: Input the Memo database database.

name for server access. » Access point: Select an access point to

» Sync type: Select the synchronization use for the data connection.
type below. » Sync mode: Select the synchronization
- Normal mode below.
The phone and the server are required - Manual
to e)fchange information about the The synchronisation will only occur
modified data. when explicitly initiated by the user.
- Backup - Automatic
The phone sends all the data from a The application will automatically
database to the server. The server is initiate a sync, based on the
expected to replac.e all data in the preferences defined (either a regular
target database with the data sent by reminder or after changes have been
the phone. This means the phone made.)
overwrites all the data in the server
database. - Sync frequency

Select the automaic sync preference
when you choose automatic sync mode.
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Network (Menu #.74)

Select Network
Select between Automatic and Manual.

» Automatic: Automatically searches for the
network and registers the handset to the
network. This is recommended for best
service and quality.

» Manual: All the currently 2G(GSM) and
3G(UMTS) available networks are shown
and you can select one of them for
registration. If the registration of the
network has failed, all the currently
available networks are listed again and you
can select any other one for registration.

Network mode
You can set a type of network to search for

» Automatic: Searches all the networks
connectable.

» UMTS: Searches only networks supporting
3G.

» GSM 900/1800: Searches only networks
supporting GSM 900/1800 band.

» GSM 1900: Searches only networks
supporting GSM 1900 band.

Preferred lists

If the network is searching automatically, you
can add a preferable network to be
connected to. And the following options are
available.

» Add new: You can add a new network
using the followings.

- Search: You can select one from the
network list stored in the phone.

- Enter new network: You can enter the
country code (MCC), the network code
(MNC) and RAT to add.

» Delete: Deletes the selected network.

» Edit: You can modify the information of
the selected network.

» Move up: Moves the selected network
upward.

» Move down: Moves the selected network
downward.
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Settings

Access points (Menu #.75)

This menu shows the access point list. You
can create new profiles, delete or edit them
by using the Option Menu. However, you
cannot delete or edit default configurations
depending on country variant.

You can edit the following configuration

tiems by selecting the left soft key and Edit.

Connection title | Access Point profile name.

Bearer Choose the bearer from the list.
(Default is UMTS.)

Choose the authentication from the
list. (Default is No auth)

Authentication

User name Information provided by service

provider.

Password Information provided by service

provider.

APN APN name to access network.
Information provided by service
provider.

» Press Select key to save any configuration
changes.

Browser settings (Menu #.76)

Profiles

Select the appropriate profile by pressing
@ . This will activate the profile to initiate
browser launch.

Character encoding

Sets the browser default character set to one
of the following.

» Automatic, English(ASCII), English(ISO),
English (LATIN), Unicode(UCS2 BE),
Unicode(UCS2 LE), Unicode(UCS2 Auto),
Unicode(UTF-16 BE), Unicode(UTF-16
LE), Unicode(UTF-16 Auto),
Unicode(UTF-8).

Scrolling control

Allows you to set the scroll speed by
selecting the number of lines to scroll.
Select one from 1 line, 2 lines, 3 lines.

Show Image

Allows you to enable or disable image display
during browsing.



Cache

Enabling Cache allows you to store accessed
pages to your phone. Once a page has been
stored in cache it will greatly enhance the
page loading speed on subsequent browsing
of the same page.

Cookie

Enabling Cookie allows you to store cookies
sent from the server. Disabling this function
will prevent cookies from being stored on
your phone.

JavaScript

Select whether to switch JavaScript On or
Off.

Reset setting

Select this to reset your phone to its default
configuration.

Security

If user presses Certificates, certification
information is shown.

User can clear secure session information by
pressing Session clear.

Certificates

If stored, a list of root/ca certificates required
for WTLS/TLS can be found here.
Certificates can be viewed from the list.

s3umas I

Session clear

Secure (WTLS/ TLS) session data can be
cleared using this option. Session data
should be cleared to establish a new secure
session.

Streaming (Menu #.77)

If you want to set different network setting to
play streaming content, you can set different
network settings.

Java settings Menu #.8

Activating a profile

1. Move the cursor to the profile you would
like to activate.

2.Press @.
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Adding a new profile

1. Select Add new from the Options menu.
The following items need to be configured.

Service name

Enter an account name for the profile.

Connection
mode

Choose from the given list of
connection modes. (Default is TCP
with Proxy or TCP without Proxy)

IP address

Enter the WAP Gateway IP address
provided by the operator. (e.g. 195.
15.025. 129)

Proxy server
port

Port details are provided by the
operator, depending upon the
Connection mode.

Access point

Choose from the given list of access
points. (For more details on adding or
editing a new access point, refer to
page 98.)

2. Press the @ [Done] to save any
configuration changes.

You can edit and delete a profile by selecting
Edit and Delete from the Options menu.
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Accessories

There are various accessories for your mobile phone. You can select these options according to
your personal communication requirements.

$911055320Y I

Travel Adapter Hands free ear-microphone and music

This charger allows player controller combo

you to charge the

battery while away
from home or your
office.

Stereo headset

Controller: Answer &
Standard Battery End key, music player
control, volume control,
Hold button and microphone.

After connecting the headset and the
Data cable/CD controller, plug the end of controller into the
headset jack on the right side of the phone.

You can connect your
phone to PC to
exchange the data
between them.

Note
» Always use genuine LG accessories.

» Failure to do so may invalidate your
warranty.

» Accessories may vary in different regions:
please check with our regional service
company or agent for further
information.
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Technical data

General
Product name: KU580

System: GSM900/DCS1800/PCS 1900,
WCDMA 2100

Net weight: 67.5g(Without battery)

BIEP [BDIUYDI] I

Ambient Temperatures
Max: +55°C

Min: -10°C
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